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1

General Information

Connect+ is enterprise management software designed to
monitor your store or region performance in real time.
Currently Connect+ supports Emerson Controllers E2,
Site Supervisor, and Dixell.

This document provides a step-by-step guide for Store
Managers or Monitoring Technicians on how to use
Connect+ to monitor your stores or regions. The following
topics are included in this user guide:

How to use an Advisory Map to locate your
problematic sites.

How to locate sites that are not sending alarms.
How to diagnose advisories .
How to review Live Advisories from controllers.

How to monitor stores in real time and compare
store/device performance.

How to access controllers and schedule jobs to read
data.

Tips to process Live Advisories.
How to override and manual defrost.

How to search a site, a controller or a device in your
enterprise.

Review Enterprise Summary including stores,
controllers and devices information.

How to export store data.

Terminology

Advisory: Alarm/Notice generated from
controller, or notification from Connect+.

Graphical Screen: Floor Plans or Summary
Screens for real time store monitoring.

Tree Hierarchy:

*Directory: A region or a banner of a
customer.

«Site: A store in a region or banner.

*Control System: A set of controllers within
one store.

«Unit: Controller

*Application Type: The type of application
that has been set up inside a unit (controller)
Example: AHR, Circuits, Condenser,
Lighting Schedule, User Access are all
App Type.

*Application: Apps are programmed inside a
controller to access a physical device or define
the controller setting.

*Point: Application’s data attributes.

+ Activity: A job that a user conducts to access
the controller.

*Obtain Controller Information: Obtain
controller hierarchy including every
controller, application, and points.

*Refresh Unit: Refresh controller Information.

*Refresh Application: Refresh the applications
of a controller.

*Refresh Point List: Refresh all the points of an
application type/application.

*Retrieve Logs: Get log data from one or
multiple points.

*Manual Defrost: Defrost a freezer manually.
*Override/Modify: Change a Point Value.

*Display Log/Real Time Graph: Display log
graph or real time graph for a specific point.

Terminology

General Information ¢ 1



2 Logginginto Connect+

2.1 LoglIn

Before logging into Connect+, contact your manager or IT department to obtain your Connect+ login credentials.

<
EMERSON

Figure 2-1 - Connect+ Login

Upon your first login to Connect+, you will be asked to change your password. Please enter the generic password you
received as Current Password. Select a password with no less than 8 characters.

~
EMERSON

Reset Your Password i

Figure 2-2 - Reset Your Password

2 ¢ Connect+ General User Guide 026-1020 Rev 2



~
EMERSON

Login

Login ID

Password

Figure 2-3 - Connect+ Login

If you have forgotten your Password or Login ID, click Forget Password or Forget Login ID. You must have a valid
email in your user profile with Connect+ in order to receive the temporary password or Login ID.

2.2 Navigate Connect+

Once logged in, you will see the Connect+ Ul is designed with four areas.

s a3

8 [ - amced Suczion
# [} Pecsie Camarar
# [] Semerw Semz

# [ ool Don

Figure 2-4 - Navigation Panel

Navigate Connect+

Logging into Connect+ « 3



* Area 1 contains main toolbar icons for you to
access Enterprise Level Information, such as
alarms, sites without alarm connection, Store/
Device Summary, Schedule Jobs, Global Search
etc.

* Area?2 is the Navigation Tree, which is set by your
Administrator to reflect your Enterprise Hierarchy.
The navigation tree starts from the Directory level,
which reflects the region or banner you belong to,
then the Site level, which reflect your stores. Under
each store, you can review the controllers installed,
down to the devices the controller controls and
device attributes. When you right-click on each
level in Navigation Tree, you will see the Right-
Click Menu, which is provided to review
information or perform activities to access
controllers.

e Area 3 is the Context Menu, which is associated
with your Navigation Tree level. The Context Menu
is same as the Tree Right-Click Menu.

* Area 4 is the major Review area. When you click
the enterprise toolbar and Navigation Tree right-
click menu or context menu, the information or
controller activity progress/result would be
displayed in this area.

2.2.1 Connect+EnterpriseToolbar

Navigation

—
(]
| w#m Home pags

Hide Mav Frame

Figure 2-5 - Toolbar Navigation

Count indicates the Total Number of
Active Alarms in the Past 24 Hours. Users
will be directed to View Advisories upon
selecting.

Advisory

Count indicates the total number of sites
without connection in the past 24 Hours.

i ith . .
Sites without Users will be directed to the

Connection . . .
Connection Verification Report upon
selecting.
Users will be directed to their own
Homepage Connect+ Homepage once preferences are
set.
Enterprise Enterprise Summary contains region,
Summary site, controller and device information.

Access to Schedule Manager and
Activity History to

* Schedule different activities to
execute job on the controller

Header Menu

* View activity result and detail

Language

Setting Allow user to change Language Setting

Offers Global Search for your Site
Homepage and global search for any sites,
controller, devices or points.

Global Search

Table 2-1 - Toolbar Navigation Legend

Note: Details about Advisory Map, Advisory View, Site
without Connection, List Power Builder, Schedule
Manager. Enterprise Summary and Global Search would
be covered in later sections.

2.2.2

Store Hierarchy by
Navigation Tree

As you can see from the Navigation Tree of Connect+
landing page interface, a store hierarchy is reflected by the
Tree listed with the concept of Directory, Site,

Control System, Unit, Application Type. Application
and Point.

4 « Connect+ General User Guide
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Figure 2-6 - Forget Password

2.2.2.1
Directory

Directory is a region or a banner of a customer. Connect+
offers a sub-directory under the parent directory to reflect
a customer’s own organization structure.

Definition of Tree Hierarchy

Sites

Sites are stores in a customer’s organization. One site
belongs to only one Directory.

Control System

A control system is a set of controllers within one
localized store. A typical grocery store control system
would contain building management controllers and
refrigeration controllers.

Unit

A unit is an individual controller at a site belonging to a
control system. There may be more than one unit in each
control system. One controller would be configured as the
gateway in the control system to communicate with
Connect+

Application Type

An application type is the type of application that has been
set up inside a unit (controller). There are many types of
applications programmed into the controller. All
application types contain applications that belong to the
same application type.

Application types ranges from physical applications that
connect to a real device, such as air handlers, standard
circuit, sensor control analog and digital combiners.

Or logical applications such as zones, power monitoring,
global data, time and dates, time schedules, user access
and more.

See below for a REF Controller Application Types and
Building Controller Application Types examples:

IR E2
3 B Bx-400 1: HVAC/LTS

9 [3 elebal Data
# [3 Heav'Cool Contral

@ [3 Sensor Control DV
# [ Time and
4 [@ Time 5ch
3 [{user

Figure 2-7 - Application Types
Application Instance

An application instance shows the application (if
available) that has been programmed inside a controller to
access a physical device or define the controller setting.
Through the application instance, users can either access a
physical device’s data points, such as an ice cream case
controller. Or access to applications that are programmed
to configure the controller, such as user access or alarm
settings.

Point

Application points are attributes that have been
programmed inside a controller application. Access to
application points allows the user to view details about the
points, graph points, retrieve logs, and make changes. In
Connect+, there are three categories of points: Input,
Output or Parameters.

An input point can be associated with an output point of
the same data type, and vice versa (for example, digital
outputs to digital inputs, analog inputs to analog outputs).
An input point cannot be associated to another input point,
likewise, an output point cannot be hooked to another
output point.

Navigate Connect+
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* Active Points is the default each time the user starts up the browser and will show all configured points in the
controller.

* Active with Logs shows active points that have a controller log available.

* Points with Logs shows points that have a controller log available.

All Points_shows all possible points for an application instance, whether a point is configured or not. An icon will

appear next to the point if the point has a log.

4 All Points

Points with Logs

Figure 2-8 - Active Points

2.2.2.2

Tree Levels

» Advisory View: At any level, you will have access to Advisory View, which allows you to review advisories for a
region, store, controller or device.

* Graphical Screens: You can also access different summary information at each level, which is illustrated as
System Graphical Screens.

» Controller Access: You can only access a controller at the control system level and controller level. From the
controller level, you can remote login using Terminal Mode.

» Controller Activity: you can perform three types of job at different levels:

Any Level: Retrieve logs

Directory/Site/Control System/Controller Level: Obtain controller information
Controller Level: Refresh application

Application Type Level: Refresh point list

Application Level: Manual defrost freezer or cases

Point Level: Override/modify point value, display log/real time graph

6 ¢ Connect+ General User Guide 026-1020 Rev 2




Other Summary

Tree Level System Screens Controller Activity Controller Access
. . Obtain Controller Information
Directory Advisory Map . NA
Retrieve Logs
Ref S
. e' ?mmary Obtain Controller Information
Site Building Summary NA

Retrieve Logs

Control System

NA

Obtain Controller Information
Refresh Units
Retrieve Logs

View Network Status

Obtain Controller Information

Terminal Mode

Unit Controller Summary Refresh Units View Network Status
Retrieve Logs Controller Logs & Status
App Summary Refresh Point List
App Type . NA
Defrost Summary Retrieve Logs
L Status Refresh Point List
Application . . NA
Graphical Summary Retrieve Logs
Override
. Modify
Point NA i NA
Display Log Graph
Real Time Graph

Table 2-2 - Tree Levels

2.2.3

Menu Access Summary

In addition to the top menu and tree hierarchy right-click menu, you can also access the right-click menu from the
Graphical Screen or Watch Point Lists.

Below table summarizes menu access for advisory and controller activity at each entry point:

. . Graphical Screen |Watch Point Right-
Top Men Tree Right-Click Men . . .
op " ee Right-Cli ent Right-click Menu click Menu
AfiVlsory Enterprise Any Level Point Level Point Level
View
Run Once or Schedule Only Run Once from Right-Click
Menu
Retrieve Logs
Obtain Controller Info
Refresh Unit
eresh S . Retrieve Logs Retrieve Logs
From Schedule Refresh Application Override Override
. . Manager, user can Refresh Point List . .
Activity Modify Modify
choose Run Once or Manual Defrost . .
. Display Log Graph Display Log Graph
Run by Schedule Override
. Real Time Graph Real Time Graph
Modify
Display Log Graph
Real Time Graph

Table 2-3 - Menu Access Summary

Navigate Connect+

Logging into Connect+ « 7




2.3
2.3.1

Complete My Profile and Set Preference

Profile & Preference

You might want to check your User Info to complete and set preferences. Click the icon next to your name and then click

User Info.

User Info
My Home Page

Logout

Set As Home Page

Figure 2-9 - User Info

Complete Email

If you do not currently have an email, we recommend you enter that information. Without email information:

* You cannot receive emails from Connect+ when you forget a password or forget the login ID process.

* You also cannot receive the verification code during login if your organization decides to turn on Multifactor
Authentication.

Updated Password

If your organization has activated Reset Password Every 90 days, you will be reminded to update your password when

your current password is expiring within 14 days.

User Information

Login ID f
First Name Fz
Last Name ]

Update Your Password

Current Password
New Password
Retype New Password
E-mail

Preferences

Show @5 Screen Sdic Tool
[#! Enable Home Page
Current Home Page: System Advisory Screen
Hide Nav Frame

¥ Enable GS Screen Auto Log OF

Units

Temperature
Temp. Change
Temp. Rate Change
Pressure, Large
Pressure, Small
Velacity, Air
Velacity, Liquid
Liquid Velume
Volume Flow
Current

Light

Weight
Enthalpy

Fahrenheit [OF)
Delta Fahrenheit [DDF)
degrees F/hour (DFH)
peundy: 1]

in of water
faet/minute [FPM)
gallons/minute (GPM)
gallons (GAL)

pounds (LBS)
Btu/lb

Rl T T e T T

Figure 2-10 - Update Your Password

8 » Connect+ General User Guide
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Setting Preferences

» Show GS Screen Edit Tool: This allows GS Screen menu visible on the right-click tree menu, default is not
enabled.

* Enable Home Page: This allows you to set your Connect+ Homepage, default is not enabled.
» Hide Nav Frame: This allows you to hide the Navigation Tree. Default is a visible Navigation Tree.

* Enable GS Screen Auto Logout: This allows you automatically logged off due to GS Screen page inactivity for
30 minutes.

» Engineering Units: English/Metric/Global; default is set to English Units.

User Information Units
- , BT T T
First Name Fa
Last Name o Temperature Fahrenhsit (DF)
Temp. Change Delta Fahrenheit [DDF)
Temp. Rate Change degrees Fhour [DFH)

Update Your Password

v
v

v

Pressure, Large pound/sq in [PST) d

Current Password Pressure, Small in of water (INW) hJ
Velocity. Air feet/minute (FPM) v

New Password Velocity, Liquid =
Retype New Password Liquid Volume v
E-mail Volume Flow v
Current eres (A) i

Preferences Light foct-candles (FTC) T
Weight pounds (LBS) d

Show 65 Screen Edit Tool Enthalpy Bru/lh Al

[#] Enable Home Page
Current Home Page: System Advisory Screen
Hide Nav Frame

¥ Enable G5 Sereen Auto Log OF

Figure 2-11 - Enable GS Screen

* You can set your language preference directory from the enterprise toolbar. Currently you can choose English or
Spanish.

Cizco/n—c @ o~ ©

Figure 2-12 - Language Preference

2.3.2 SetConnect+ Homepage

When you enable the Homepage setting, you will see the Set as Homepage menu option when you click the user profile
icon next to your name. Currently Connect+ allows you to set Graphical Screens as your Connect+ Homepage.

We recommend you set the Enterprise Advisory Map as your Connect+ Homepage to better optimize your Enterprise
overall performance.

If Advisory Map has been enabled for your organization, you can access Advisory Map at the Directory level. Click your
organization’s parent directory, or access from right-click menu > Advisory Map

Complete My Profile and Set Preference Logging into Connect+ * 9
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Figure 2-13 - Advisory Map Page

When you are on the Advisory Map page, you will see all sites in different alarming states. Advisory Map allows you to

have a quick glance on your S
your name.

ites’ status in the past 24 hours. Click Set As Home Page from the user profile icon next to

W(é;)ﬁq\c

Map Satellite

o I 0. © v reoes O &
Set As Home Page
@ Advisories  Setpoints Food Quality ~CB Maintenance Energy Refrigerant Reporting  File Edit User Info
My Home Page
Logout
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Figure 2-15 - Graphical Screen

You can also set other Graphical Screens as your Homepage. As introduced in the What is Connect+ session, Graphical
Screens are Floor Plans or Summary Screens for real time store monitoring. You can access these Graphical Screens from
the Navigation Tree, when you right-click on any level, you will see a list of System Summary Screens indicated with blue
icon, and customized graphical screens with an orange icon.

= I Demo
+ iy 00211

154 Atlanta

] Refrigeration Summary

] Building Summary

2. ] Other Summary
® Demo Refrigeration Summary
# E2 Store Summary
¥ Summary

Open any Graphical Screen at any tree level, then click User Profile > Set As Homepage,
then the Graphical Screen will be set as your Connect+ Homepage.

Note: You can also set Homepage for each site, this will be covered when we review more
details into Graphical Screen Session.

10 » Connect+ General User Guide 026-1020 Rev 2



2.4 Manage Your Own List

A list contains points that you are interested in. You have flexibilities to choose your preferred points from different

stores, controllers for same application type to compare store performance. Or you can also select a number of points for a
single store or controller to monitor.

You can also create list for yourself via List Power Builder. Access List Power Builder from the link of Watch or Graph
Points page.

Watch Or Graph Points

Select points to watch or graph by using the checkboxes in the tree.

Load Selection from Iist‘ ...select list... v

Notes:

Disabled point names indicate points which only have logs and cannot retrieve real time values.

List Power Builder

Figure 2-18 - Watch or Graph Points

. . Criteria
Watch Points Lists Use * {asterisk) for wildcard at the start or end of a match string.
Select a list to load or type in @ new List Name to create a new List, | Separate multiple matches in a single field with commas. additiona
Help
|| Directory
# Site
) - =‘E‘a£c'|:r3| System
Lead List wselect ist... » g Unit
List Name B Application Type
[] Application
Instance
F v
ol CELRRTY e wLogs v
| Point
Add Te List
List Size: 0
H‘-‘c.iDr iE':e i |

cs |L|": |.=3:- Type |.=3:- Inst |Ca:ego".- |Po"|: |

Figure 2-16 - List Power Builder

You can create a new list by entering your criteria to the right. For example, if you want to get all Case Controller
Temperature points, you can leave Directory/Site/Control System/Unit blank, fill in your Case Controller Application
Type name. If there are multiple names, separate them by commas. Then enter the Point Name as the same name from
your tree. Click Add to List and the list of points would be retrieved as below.

You can also filter points and remove filtered items to further refine your List.

Manage Your Own List Logging into Connect+ * 11



Watch Points Lists

Select a list to load or type in @ new List Name to create a new List,

Lead List wiselect fist... ¥

List Name [AHU List 04252020

Criteria

[ ] Directory
4 Site
ShaControl System

B unit

Use * (asterisk) for wildcard at the start or end of a match string. Separate multiple
matches in a single field with commas. Additional Help

[ Application Instance

[ Application Type  [FAHUT

Point Catagory ¥ || Active Peints v
| Point
Save as new
List Size: 10000 | Removs Al Ttems
Ne.| Dir Site cs Unit [Ape Type Category Point
ki

<1 Site 2 55 BX=:HVAC/Litz  |AHULarge AHU 1 Params A FreezeStat input is too lowl
|2 Site 2 55 BXe:HVAC/Lite [AHULarge AHU 1 Params A FreezeStat input is too lowi--Category
2 Site 2 3 BXe:HVAC/Lit= |AHULarge AHU 1 Params A FreezeGtat input is toc lowl--Display Message
LAEs Site 2 S5 BXe:HVAC/Lite [AHULarge AHU 1 Params A FreezeStat input is too lowl--Menitor Alarm
|5 Site 2 55 BXe:HVAC/Lit=  [AHULarge AHU 1 Params A FreezeStat input is too lowi--Repeat Rate
|6 Site 2 S5 BX=:HVAC/Lite |AHULarge AHU 1 Params A FreezeStat input is too low2
|7 Site 2 55 BXe:HVAC/Lit= |AHULarge AHU 1 Params. A FreezeStat input is too low2--Category
<8 Site 2 S5 BXe:HVAC/Lit= |AHULarge AHU 1 Parzms A FreezeStat input is toc low2--Display Message
Lk Site 2 55 BX=:HVAC/Lite  |AHULarge AHU 1 Params A FreezeStat input is too low2--Manitar Alarm
|10 Site 2 55 BXe:HVAC/Lite [AHULarge AHU 1 Params A FreezeStat input is too low2--Repeat Rate
Showing 1 - 10 of 10000 Page Size: [ 10 A Next

Figure 2-17 - Watch Point Lists

Enter a unique name for your list. Save As a New List button will display when you have a valid list name. Click Save,
and you can later use this point list to watch your store.

’

A AR RNAERER A R

Watch Or Graph Points

Display Log Graph

1. HVAC/LTS"/&ir Handlers (AHU=)/1-MAIN AHU/Outputs/SPACE TEMP OUT

2. HVAC/LTS"/&ir Handlers (AHUs)/SALES AREA/Outputs/SPACE TEMP OUT

3. HVAC/LTS"/#ir Handlers (AHUs)/RTU-1 BAKERY/Outputs/SPACE TEMP OUT

4, HVAG/LTS"/Air Handlers (AHUs)/RTU-2A PRODUCE/Outputs/SPACE TEMP OUT
5. HVAC/LTS"/ Air Handlers (AHUs)/RTU-28 PRODUCE/Outputs/SPACE TEMP OUT
6. HVAC/LTS"/ &ir Handlers (AHUs)/RTU-3 KITCHEN/Outputs/SPACE TEMP OUT

7. HVAC/LTS"/Air Handlers (AHUS)/RTU-4 CONF RM/Cutputs/SPACE TEMP OUT
8. HVAC/Air Handlers (AHUS)/IT STORAGE/Outputs/SPACE TEMP OUT

9. HUAC/Air Handlers (AHUS)/RECEPTION AREA/Outputs/SPACE TEMP OUT

10. HVAC/Air Handlers (AHUs)/REFG LAB/Outputs/SPACE TEMP OUT

11, HVAC/Air Handlers (AHUs)/SIDNEY CONF RM/Outputs/SPACE TEMP OUT

Retrieve Logs + Graph

Retrieve Logs

NOTE: Only the first 15 paints will be used on the graph.

T T

Figure 2-18 - Watch or Graph Points
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3  Advisory Map, Advisory View and Live

Advisories

Adpvisories are defined as the notifications or alarms
generated from Controllers to report store a crisis.
Currently Connect+ support receives Advisories directly
from Emerson Controllers E2, Site Supervisor, and Dixell.
Connect+ can also receive Advisories from Danfoss if a
Danfoss Site is sending an alarm to Emerson ProAct
Alarm Service.

Adyvisory Type by Controller:

e E2: Alarm, Device Failure, Notice.

* Site Supervisor: Critical, Non-Critical, Notice.
» Dixell: NA

» Danfoss: Severe, Critical, Normal, Log Only

Advisory State:

Each advisory in Connect+ would have two states: Active
or Return to Normal.

An advisory would remain active until the condition to
generate the advisory returns to normal.

Active

Advisory occurs when a controller generates the alarm
based on Alarm parameter configured. Alarm Parameters
involved in Advisory Occurrence are High/Low limit and
Alarm Delay.

For example, a technician can configure Case Controller
Temperature Alarm Hi/Low limits for the normal
temperature range and a 10-minute Alarm Delay. Once
temperature is above or below setpoint, even above Hi
Limit or below Low Limit, the controller will wait until
the Alarm Delay passes, then generate the alarm.

The alarm will remain Active from the Advisory
Occurrence Time until the point value returns to normal.

Return to Normal

An advisory will Return to Normal once the point value is
back inside the normal range. There is another Alarm
Configuration that will affect Advisory Return to Normal
time: Alarm Hysteresis. When Alarm hysteresis is
configured, the advisory will change to state Return to
Normal only when current point value is in range of (Hi
Limit — Alarm Hysteresis) and (Low Limit + Alarm
Hysteresis).

Adyvisory Priority:

Advisory Priority is a concept with Emerson Controllers
E2 and Dixell. Connect+ provides the same concept for
these controller types:

* E21-99

* Site Supervisor NA
 Dixell 1-99

* Danfoss NA

Urgency Level

Urgency Level is a Connect+ defined Advisory Property.
When you have multiple controllers across an
organization, it is difficult to tell which advisories need
your immediate attention with different advisory
definitions for different controllers.

In order to solve this problem, Connect+ defined Urgency
Levels as shown below. This allows users to have a
consistent view of an advisory’s severity. Currently the
definition is default in Connect+:

Urgency | Priority | State |Example Alarm Type
High Room Temp Alarm
1to 20

Food Safety Case Temp & Prod

Temp
i Active | Heat Pump Status

Hedm 20 Block Alarm

Low 51t0 99 HRC Alarm from Heat
Pump

Low 1099 | RIN

Table 3-1 - Advisory Priority Explained for E2 and Dixell

Urgency Type State |[Example Alarm Type
High Room Temp Alarm
Critical
Food Safety Case Temp & Prod
. Temp
N Active Heat P Stat
. on- eat Pump Status
Medium Critical Block Alarm
Low Notice
Low Any RTN

Table 3-2 - Advisory Priority Explained for Site Supervisor

Urgency Type State
m Severe or Critical
Medium Normal Active
Low Log Only
Low Any RTN

Table 3-3 - Advisory Priority Explained for Danfoss

Manage Your Own List
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3.1 Advisory Map

3.1.1  Access problematic stores via Advisory Map

If your organization has enabled Advisory Maps, when you click on the parent directory in the Navigation Tree, you will
see an Advisory Map as shown below with the Advisory Urgency legends. You can set this page as your Connect+

Homepage for Enterprise View.

Map Satellite

United States Kansgs City

Mexico

Google

o

g

1

Terms of Use

Figure 3-1 - Advisory Map

Sites in the Advisory Map are indicated with Alarm Urgency Level in the past 24 hours. You can click on any problematic

sites to further investigate based on the below legends:

Site Severity Level

* Red indicates Sites with Food Safety Alarms/High Alarms.

* Orange indicates sites with medium urgency Alarms

| High | * Yellow Indicates sites with low urgency Alarms.

* Green indicates sites that does not have active Alarms.

* Gray and flashing indicates s there is no Alarm Connection

Past 24 hours If you know your Site Name, you can also enter the site name in the search box. The search

result will flash for five (5) seconds on the Advisory Map for you to check further details.

Map Satellite

United States

Mexico

Google

Figure 3-2 - Search Box

14 » Connect+ General User Guide
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Clicking on the Site, you will see a snapshot of the Site, which includes Site Name, Site Address, and several quick links.

TV Coumbia

Map  Satellite Lawfence

St. Louis
o

Wichita

oklandg-a city

Merpphis
o %
T
Dallas
rjens Fort Wortho © Shievesort
8 ckson

Mosie
Austin ) -

] Beaumont New Orfeans

Houston
o

San Antonio
A Calvest

Google

&
EMERSON

| 154 Aianta - 154

Washington
ing!

Richmond

Total

Norfoko oVirginis Beach

Greensboro
G ]

Jacksonville
3

Tampa
o

Sito Severity Lavel
Food Saf

[No Aarm Connectin]

Past 24 hours

+

Map data ©2020 Google, INEGL | Terms of Use

Figure 3-3 - Site Snapshot

&
EMERSON
154 Atlanta - 154

1745 Georgiz 138
Georgia, Conyers, 30013

Advisories
Active Return Total
o 4 4

¥ DOonon o>

alarm.

Advizories based on lzst 24 hours

3.1.2  Your Advisory Map Setting

* When clicking Site Name, you will be directed to your Site Home Screen if set.

* When clicking Advisory View, you will be directed to View Advisories.

* When clicking Controller View, you will be logged into the controller’s Terminal Mode.

Advisory Map View allows you to review your stores and locate problem sites as quickly as
possible. The quick links for each site provides access to locate the advisory information and
take further actions. From Advisory View, you can review Alarm Details and Log Graph. From
the controller View, you can access Terminal Mode if you need to change settings to clear the

Map Satellite @ 4
Greerland
Iceland pi- o
Finland .
oovei) Ste Sevarity Levt
Ganada Advisary Map View Setting
! Show Legend e
Jnted
® Al e el Belsrus
Al Sices reland Poland I
Gorman gk
Only Sites with Advisories 7 ol e
Kazakhstan
Jith Food Safety Ad France
sy Uzbokistan,
Urited State Greece. snistan -
¥ Portugal Turkey Turkmenistan
q;_ ZE o 2
WHEE e 7 SewmleeSesyaddsore [ = < Afgharistan
‘ Moracco i ren
f Faist @
a Ageria i
o Libra Egypt L
Hestern
Mexico m “ s Saudi Arabia in¢
Mausitanial N
G Chag | Suden Yemen
Guras
enezusia Nigoria o)
NmeziasRem ‘South Sucan ©171oP
Colombia Sname Somalia
4 3 Kerya
R - =l e e i e e e Y
DRC
Tanzania
Bl
,,,,,,,, poru
Google Angola |7 ambia .
g M Map dara-©2020 Google, INEGL | Terms of Usz

Figure 3-4 - Advisory Map Seiting

Advisory Map

Advisory Map, Advisory View and Live Advisories
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1. Map or Satellite View: Allows you to switch Google Map View or satellite view. With satellite view, you can
review a real time picture of your stores, see roof top units if available, and more.

Map Satellite

Hiap Gata £2020 INEGI Imagery ©2020 HASA, Terraetncs | Terms of Use.

Figure 3-5 - Map or Satellite View

2. Setting: If you have a large number of stores, your Advisory Map may appear full. You can filter your stores in
the Advisory Map to have focused views.

Advisory Map View Setting
¢ Show Legend
& Al Sites
Only Sites With Advisories
o ° Sites with Food Safety Advisories
o o Sites With High Severity Advisories
L . . -
i Sites With Medium Severity Advisories
v

Sites With Low Severity Advisories

° Sites With No Alarm Connection

Figure 3-6 - Advisory Map View Setting

Once you click OK, your Advisory Map Preference will be saved. When you view the Directory Advisory Map again, it
will only show the sites with your preferences.

3.2 Advisory View

The enterprise toolbar alarm icon provides a quick overview on how many total active alarms you have across your
stores in the past 24 hours. Whenever there is new alarm received by Connect+, the number will add and flash for
several seconds.

e G 0 - O

Figure 3-7 - Advisory View Legend
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3.2.1  Advisory List View

You can access the Advisory List View when you click this tool bar. As Advisory Map View, the Advisory List View is
organized by Advisory Urgency Level. Mouse over the Urgency button to see the definition of each urgency level.

Advisories View

1

Gccurrence Date |Past 24 Hours

A S

|eoscsocscsossscesn
o o o o s o i o e o B o

CrReset Filters 3 Refresh Advisories O Restore Default Format

o -

Y| Time Perspective: [Site Time. v Shew (25 ¥

ceDat=~  Age Sie Type Advisory Message Source Prio_ Applicstion Insta_ SourcaType Status Point Limic

Al v Al

4/25/20208:29AM  10.5h Blarm caseTEMRZ 20 casETEME Z 280

4/25/2020 5:46 A XWEBEVO Fierz 10

4/25/2020 12:09

CYCLERATEST. 80 CYCLE RATE STA. 240.0

4/24/202010:46 PM 212 100

. Xweb
4/24/202010:46 PM 2.2 100

nc.. Xweb

4/24/202010:46 PM 212 100

. Xweb
4/24/2020 10:46 PM 212 h r. Danfoss

4/25/2020 4:46 A 21.2h

4/25/20208:16 A 21.2h
4/24/202010:46 PM 212 h

4/25/20204:46 A 21.2h

s
£
£
s

4/25/20204:46 A 21.2h Fs
£
3
s
s

4/24/20203:46BM 2225

Figure 3-8 - Advisory List View

Column Name Description
Occurrence Date | Shows the date and time when the advisory was generated on controller.
Received Date Shows the date and time when the advisory was received in Connect+
Shows advisory duration.
Alarm Age * If'the advisory is still active, Alarm Age = Current Date time — Occurrence Date.
+ If the advisory is return to normal, Alarm Age = Return to Normal Date — Occurrence Date.
RTN Date Shows the date time when the advisory is back to normal.
Source Shows controller, application, and property information from where the advisory was generated.
Source Type Cor'mect+ will also generate advisories in ad('iiti(')n to cpqtrgllers. Such as Controller Offline Alarm, Predictive
Maintenance Alarm, and more. Source Type indicates if it is from the controller or Connect+ Apps.
Point Shows the point from which the advisory was generated.
Limit Shows the I}igh or lgw limit th'e a'dvi'sory will exceeded to generate the advisory. This is usually configured by
your Technician during commissioning phase on the Controller.
Trip Value Shows the point value when advisory is generated.
Advisory Shows an explanation of the advisory. This is usually configured by your Technician during commissioning
Message phase on the Controller.
Add Comment Users can enter a comment for the selected advisory.
Comment Shows the latest comment a user entered.
Different controllers using different Type to categorize Alarm Severity.
Type » E2: Alarm, Fail & Notice for E2
* Site Supervisor: Critical, Non-critical and Notice
Priorities It shows urgency level of advisories as numerical (1-99). It is configurable in Controller

Table 3-3 - Advisory List

Advisory View
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3.2.2 Read Alarm Related Log Graph

From Advisory List View, you can access the Advisory Detail Information and login to the controller if needed.

* Access Point Log Graph from Advisory Message link

From Advisory View, you can only see alarm-related points log graph. The same applies to log graph in advisory email.
You can read multiple points Log Graph from Watch Points and Graphical Screens, which will be introduced in a later

session.

onoff

16:20 17:00

§ 15¢ Adama/LTE RI FROZ FD/DEFROST

<+ B 154 Adlenta/LT3 RI FROZ FD/Case Alarm Hi(no log in controller)

Advisory Hessaze Soures i

CASETEMP L
CASETEMR 1

CASETEMR 1
CASETEMP 1
CASE TEMP 1

CasETEMR 1

CASE TEMP 1

BmssDev

Range 1H GELE 12H 1D 2D 4D 1W 4w

SiteTirre cj B E =

Figure 3-9 - Log Graph

The information below will help you to read the Log

Graph:

Item

Description

Log Graph Range

Set the time range of the data to show
points logged in a graph.

Alarm Status

Shows advisory points and its related
points value and alarm status.

Point Log

Shows advisory point and its related

points log in graph.
Defrost Cycle Shows defrost status in graph.

You can choose time perspective,
Setting download, print, and save log graph

date range as default.

Table 3-4 - Reading the Log Graph

3.2.3 Other Quick Links

From Advisory List View, there are other quick links to:
* Access Site Home Screen from Site Link
* Access Controller Summary Screen from Unit Link

» Access Application Summary Screen from
Application Type Link
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3.2.4 Filter Advisory List View

Filter Advisory List by Urgency Level or Occurrence Time.

Advisories View
| High ~ |
1
ccurrence Date Time Perspective: [Ste Tma v Show(25 ¥
© Reset Filter| Co i Default Format
ot Age site Type  Advisory Message Source Prio... Application Insta.. Source Type Status Point Limit
Al | e

e 325/2020 8:25 AM 106 h Blarm  Case Temp Hi Limit Exceeded 20 L2 SOKBEER  Device B CASETEMRZ 480
e E 4/25/20209:96 am 163k i Controller Not Sending Alarms sinc. 10 System

e B /202010:46PM 213k Fai Cantraller Not Sending Alzrms sinc. 10 System

e B /2020 10:46PM 213k Fai Gontroller Not Sending Alarms sinc. 10 System

B /2020 10:46PM 213k Fai Gontroller Not Sending Alarms sinc. 10 System

o E /2020 10:465m 213k Fai Unknown Code: 20,001 (Coneroller. 10 System

e E /2020 4:06 am 213k Fai Contraller Not Sending alarms sinc. 10 System

e B /2020 4:26 M 213k Fai Cantraller Not Sending Alarms sinc. 10 System

e B 4252020 8:16 AM 213k Fai Gontroller Not Sending Alarms sinc. 10 System

®E 41242020 10:46PM 213k Fai Gontroller Not Sending Alarms sinc. 10 System

®oE 4/25/2020 4:86 4M 213k Fai Controller Not Sending Alarms sinc. 10 System

@ B s 4f24/20209:56PM 223k Fai Unlnown Codet 20,001 (Conerollar. 10 System

Figure 3-10 - Filter Advisory List

Filter Advisories by Filed Filter. For example, if you enter “Case Temp” in the Advisory Message field, you will filter
all the alarms with an advisory message that contains “Case Temp”.

Advisories View

1
1

Occurrence Date |Past 24 Hours v Time Perspective: | Site Time v Show (25 ¥
(Reset Filters 3 Refresh Advisories ) Restore Default Format
Occurrence Date v Age Site Type Advisory Message Seurce Prio.. Application Insta.. Source Type  Status Paint. Limit
v Al [ ™ e
4/25/2020 8:29 AM 10.7h Alarm 20 A12 SDK BEER Device Accepted CASE TEMP 2 48.0

Figure 3-11 - Filter Advisories

3.2.5 Customized Advisory List View
You can customize your Advisory List View by:
* Adding or removing more columns as indicated below.
* Dragging the column header to reorganize your field sequence.

* Clicking each column header to sort the list.

Your preferences will be saved for future viewing.

Occumance Dats [Past 24 Hours Y| Time Perspective: [ Site Time v

Show[25_ ¥
] Add Comments

CresetFiters  GRefrech Advisories O Restore Default Format

Urie 1D
AL s Occurrence Dtz v [Age swe Type ||+ dvisory Message Prio.. Application Insta.. SourcaType Stams  Point Limie
¥ see
Acsive ~ T [T

@] Occurrence Date

® B 2520208290 06h 2 AZSOKBER  Deviee CASETEMPZ 430
) Age

®E 4/25/20209:46 M 16.3B N A 1 System
@ s

® B s24/2020 10:46 oM 2138 o Syseam
ti

® g 4242020 10:46 PM 203 o Sysem

®E 424/2020 10:46 M 213 2 10 Sysem

®E r24/2020 1048 oM 2130 ¥ 0

® 2520204468 2136 i o Syssem

® B sf25/2z04:46 AM 213 4 o System

e B 425020816 A4 2130 o System

® g 4242020 1046 PM 2130 4 10 System

®E 425/20204:46 AM 21.3h Fail 10 Syszem

e B saa2020 96 0M 2230 Fail Unknown Code: 20,00 [] Control System 10 System

£
v
¥ Lmi
Displaying advisaries 1 - 12 of 12
9] Trpvalie
@ RN Date
¥ Urgency
@ Com -
2018 Emerson Electric Co. Al rghts reserves. - Comnect:
Server Time: Sat Apr 25 08:05:14 PM EDT 2020

Figure 3-12 - Advisory Manage
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3.2.6  Access Advisory List View

from Navigation Tree

= Do
4 oo
4 #0215 Xisn
1 3
# i 100 Kennesaw
# i 152 Lab

154 Atlanta

You can also access Advisory
View from all levels in the
Navigation Tree by clicking

P Refrigerstion Summary
£ Buiding Summary

e Right-click Menu >
ey Advisories > View
== % Adyvisories.

This allows you additional
flexibility to access advisories
at a certain site, controller,
device or a known point.

Refrigerant

3.3 View and Process Live

Advisories

3.3.1 View Live Advisory

If your organization does not enable Advisory Receiving
in Connect+, then Live Advisories will be where your
advisories can be reviewed. Connect+ will access the
control system or controller to get Live Advisories on the
controller when you click Right-Click Menu >
Advisories > View Live Advisories from Navigation
Tree at Control System or Controller Level.

Live Advisories View

Oceurrence Date [A v
(ResetFilters {3 Refresh Advisories %) Restore Default Format
Occurrance Date v Ty Uniz Source
Al
04/25/2020 16:06:02 RX-400 3: PROTO 4/8.
04/25/2020 10:06:12 ) RX-4003

04/25/2020 04:06:03 ) RX-4003

04/24/2020 22:06:12

04/23/2020 10:06:18

04/23/2020 04:06:02

04/22/2020 22:06:18 B FISH CLR :PRODUCT TEMP 1
04/22/2020 16:06:07
04/22/2020 11:33:19
04/22/2020 11:33:19
04/22/2020 11:27:24
04/22/2020 11:26:20
04022/2000 11:25:19

I

5 FISH CLR :PRODUCT TEMP 1
.. PROTO A/B:ATC MONITOR A :COMMAND OUT
.. PROTO A/B:ATC MONITOR B :COMMAND OUT

Ry-400 3. pROTO AR
L 2

Cooler: CASE TEMP 1

Show[25 ¥
Status Advisary Message Advisary Limiz Property Value
Product Temp Hi Limit Excasded 21.0 66.2
41.0 562
21.0 66.2
41.0 662
41.0 6.2
41.0 6.2
41.0 6.2
41.0 6.2
21.0 66.2
41.0 6.2
41.0 6.2
41.0 6.2
o rod 41.0 6.2
Unacknowledged Digital OFF OFF
Unacknowledged Digital Sensor Alarm OFF OFF
Case Temg Hi Limit Excesded 100 122
c ma Hi Li 41.0 40.0
i Hi Limir Exreedad 410 234 hd
Disolaving advisories 1 - 25 of 612

Figure 3-13 - Live Advisories View

Field Name

Description

Cleared Date

Shows the date time when advisory is cleared on controller.

Status

Shows whether the advisory has been Acknowledged, Unacknowledged, or Muted.

Table 3-5 - Live Advisories

When you select one advisory, you will see the option to view Expanded Info, or connect to Terminal Mode if you have

the permission.
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C*ResetFilters  £3Refresh Advisories € Restore Default Format  /{Acknowledge  /TReset  /“Clear I;:_PExpmded Info Terminal Mode I

Occurrence Date v Type Unit Source Pr.. Status Advisory Message Advisory Li.. Property .-
v Al v
o 04/30/2020 02:17:22  Al.. RX-400 2:.. RAKLT/TC:MTPREP RUN PR... 20 Unacknowledged Digital Sensor Alarm OFF OFF

Figure 3-14 - Expanded Info or Terminal Mode
Click on Expanded Info, you will see the Advisory Details:

Live Advisories View

Expanded Info 3
Name valus
Occurrence Date [Al v Occurrence Datz  04/29/2020 14:19:23
Source RAK LT/TC:LT4 RI FROZ FD:CASE TEMP 1
CResetFitters  GRefresh Advisories D Restorel ry Me Case Temp Hi Limit Excesded
Occurrence Date v Ty... Unit S Tyee Alarm =
~ Briarity 16

04/30/2020 02:17:23  A.. RX-4002:.. R St=s Unacknawledged

04/20/2020 15:45:01 .. RX-4002:.. R/  Propery Value 43.30F

04/23/2020 15:45:00 N.. RX-4002:R.. R | Advisery Limit 4L0cF

Returned to Norm_  Yes

04/29/2020 15:43:00 N.. RX-3002:R. RY

04/29/2020 15:45:00 M. Rx-a002:R. || ReturntoNormal.. 04/29/2020 14:20:13
04/29/2020 14:37:23  A.. RX-4002:.. R/ U7 RX-400 2: RAK LT/TC

4 04/29/2020 14:1%:23 Al. RN-4002:R. RJ
04/23/2020 14:19:23 Al R¥-4002:R. RS
04/29/2020 14:19:23 RX-400 2: R RJ m
04/29/2020 14:1%:23 RH-400 2: R RJ
04/29/2020 14:19:23 Al. RX-400 2:R.. RAKLT/TC:LT3 RIFROZ FDiCAS.. 16 Unacknowledged  Case Temp Hi Limit Exceeded 15.0 44.7
04/29/2020 14:16:12  N.. RX-400 2:.. RAKLT/TC:System : 50 Unacknowledged Controller startup 0 0
04/28/2020 14:14:41  N.. R¥-4002:.. RAKLT/TCiSystem: 50 Unacknowledged Controller o o
04/27/2020 10:13:54 Fa.. R¥-4002:R.. RAKLT/TC:PROTO A/B 15 Unacknowd Device absent from network 0 0
04/27/2020 10:13:43 F= RY¥-400 2:R. RAK LT/TC:E2 Unicod 15 Device absent from network 0 0
04/27/2020 10:13:38 Fa.. R¥-400 2:R.. RAK LT/TC:HVAG/LTS : 15 vice absent from network 0 0
04/22/2020 11:27:24 Al R¥-400 2:R. RAKLT/TC:LT2 RIFROZ FD:CAS. 16 Unacknowledged  Case Temp Hi Limit Exceeded 10.0 132

Figure 3-15 - Expanded Info

As an Advisory View, you can sort, filter and add more columns for your review. You can also export to Excel, PDF or
HTML file types.

3.3.2 Process Live Advisories

When you select one or multiple live advisories, you will see three options to process live advisories as shown below:
Acknowledge, Reset and Clear for E2 advisories:

CResetFilters 3 Refresh Advisories <) Restore Default Format | /{Acknowledge /" Reset /fClear | ¢ -Expanded Info  [*] Terminal Mode

Occurrence Date » Type Unit Source Pr.. Status Advisory Message Advisory Li.. Property ...
v All v
# 04/30/2020 02:17:23 Al.. RX-400 2:... RAKLT/TC:MTPREP RUN PR... 20 Unacknowledged Digital Sensor Alarm OFF OFF

Figure 3-16 - Three Options

Acknowledge, Reset and Mute for Site Supervisor Advisories:

(*Reset Filters €3 Refresh Advisories ) Restore Default Format Ig"(Achowledge Reset /% Mute I <" Expanded Info Terminal Mode

Occurrence Date Ty.. Unit Source Pr.. Status Advisory Message Advisory Li.. Property .. P.. C.. R..
v All v
04/21/2020 13:07:43 Cri.. SF:Kennesaw 8RO-1 20 Unacknowledged Network Device Offline Offline Offline o
04/21/2020 13:07:38 Cri.. SF:Kennesz 15AI-1 20 Unacknowledged Network Device Offline Offline Offline o
04/21/2020 12:25:07 Cri.. SF:Kennesaw 16AI-1 20 Unacknowledged Network Device Offline Offline Offline o
04/07/2020 08:29:00 Cri.. SF:Kennesaw XR75CX001 Cooler 20 Unacknowledged Network Device Offline Offline Offline o
# 04/06/2020 11:12:05 Cr.. SF:Kennes... Circuit 01 Cooler:CASE TEMP 1 20 Unacknowledged Case Temp Hi Limit Exceede... 40.0 74.0 = ]

Figure 3-17 - Acknowledge, Reset and Mute
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Acknowledge Advisories

When you acknowledge an Advisory, you prevent it from ever annunciating again in any way until you manually reset or
clear the Advisory. A condition that causes an Advisory will never automatically return to normal when it is
acknowledged. When an Advisory is acknowledged, the advisory stays in the controller Advisory Log, but all
annunciation of the advisory is suspended until the alarm is reset or cleared.

Reset Advisories

When you rest an Advisory, you force the Advisory to a normal condition and the Advisory remains in the Controller
Advisory Log. Currently Reset-To-Normal Alarms will not be marked as Return-To-Normal in Connect+.

Clear/Mute Advisories

The option to clear an advisory completely removes an advisory from the Controller Advisory Log.

TIPS: ACKNOWLEDGEMENT VS. RESETTING

* Reset an alarm if you believe the condition that caused it is fixed, but you wish for a new alarm to occur if the
problem happens again.

* You MUST Reset an alarm that has been previously acknowledged to re-enable the alarm. Failure to do so will
cause the alarm to remain in ACK, and the alarm will not be generated again. AN ACKNOWLEDGED ALARM
WILL NOT AUTOMATICALLY RESET.

» Acknowledge an alarm to silence alarm panel horns or lights, ONLY IF technicians have been notified of the
problem and have been dispatched. Technicians, after fixing the problem, MUST Reset or Clear the alarm to
re-enable alarming.
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4  View Sites Not Sending Alarms

You have seen many sites that are not sending alarms from the Advisory Map. Those sites are grayed out and flashing to
bring attention to them. If you want to know how many sites are not sending alarms and more information, you can click
on Sites not Sending Alarms icon on the enterprise toolbar.

3= oo D Q. © e e ©

Figure 4-1 - Site Not Sending Alarms Legend

You will see a list of sites that are not sending alarms in the Connection Verification Report.

Connection Verification Report
Time Perspective: | Site Time v View | Problem Sites v Show |25V

O Reset Filters €3 Refresh Connections.

Directory Site Control Systam Test Canngctions Per Day Number Of Missad Connections Last Recaived Time = Nest Recsived Time Commissioned Time

Dema 2 2 2/18/20 1:57 PM 4/25/20 5:12 AM
L 1 6/12/19 2:52 PM

L 1 6/12/19 2:52 PM

Asia Demo 1 1 5/8/1% 3:23 PM 4/25/20 11:02 AM
Demo 24 24 1/31/19 10:11 PM 4/24/20 8:07 PM
L 1 12/6/18 8:51 AM

Demo 1 1 7/2/18 7:37 AM 4/24/20 9:07 PM 5/15/18 5:40 &M

10/23/19 4:52 PM

9/18/19 5:43 AN
Demo 1 11/25/18 3:46 AW
Demo 1 9/4/19 5:01 BM
Dema 1 3/3/20 7:02 AM
Asia Demo 1 4/2/19 1:24 M
Seott 1/29/20 10:53 AM
Demo 1 10/18/19 2:20 AM
Demo 1 10/3/19 4:56 PM

14 4 | page o1 b M

[+]

Displaying inbound connections 1 - 15 of 15

Figure 4-2 - Connection Verification Report

Field Name Description

. Shows the number of connection tests that occurred in the controller in the last 24
Test Connections per Day

hours.
Number of Missed Connections Shows the number of connection test missed in the controller in the last 24 hours.
Last Received Time Shows the date and time when latest connection test or alarm was received.
Next Received Time Shows the date and time when the next test connection will happen.

Shows the date and time when you configured to send advisory configuration
information such as connection test time and advisory filter priorities for alarms,
failures, and notices for E2 and Site Supervisor. And shows the first refresh unit date
time as commissioned Date for XWEB and Danfoss.

Commissioned Date

Table 4-1- Connection Verification Report
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. — Recsived Connaction Time
( Reset Filters 3 Refresh Connections -
2/18/20 1:

PM

2/18/20 10:58 AM

2/18/20 5:14 AM

2/17/20 5:14 PM

| Connection Verification History

Demo f 152 Lab [/ Site Supv
me Most recent 30 connections will be shown.

Status

¢ Rece Totzl alzrms reczived = 1

¢ Receiver - Finished receiving alarms.
Advisory Receiver - Total alarms received = 1
Advisary Receiver - Finished recsiving alarms.

Advisory Receiver - Total alarms received = 0

Advisory Receiver - Daily Connection Test Recsived

Advizory Receiy Finished receiving zlzrms.

¢ Raca Total alzrms recsived = 0
¢ Recei
¢ Recel Finished receiving alarms.

Totzl slzrms recsived = 0

Finished receiving alarms.

ozl alarms recsived = 0
aily Conn:
Finished rec

<iving slarms.

Daily Conneaction Test Recaived

Daily Connaction Test Recaived

n Test Received

Additional Info

Figure 4-3 - Connection Verification History

As in the Advisory View, you can sort, filter and add more columns for your review. You can also export to Excel, PDF or

HTML file types.
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5

Monitor Site from Graphical Screens

5.1

Graphical Screen

As introduced in the What is Connect+ session, Graphical Screens are Floor Plans or Summary Screens for real time store
monitoring. You can access these Graphical Screens from the Navigation Tree, when you right-click on any level, you will
see a list of system screens indicated with a blue icon, and customized screens with an orange icon.

= W Demo
H iy 00211

021% Xian
154 Atlanta

B Refrigeration Summary
E3 Bu Iding Summary
A Other Summary
Demo Refrigeration Summary
# E2 Store Summary

M Summary

* System Screens are provided by Connect+ with predefined summaries at site,
controller, application type and application level.

* Customized Screens can be developed by yo

ur Administrator or Emerson to facilitate

your customized needs to monitor or compare store performance.

5.2

What You Can Do with Graphical Screens

You can right-click on Point Value and Override a Point, and also Display Log Graph, Real-Time Graph and view
advisories for the point. You can also override a point from graphical screens. Note that you can only use the right-click

menu in the Point Value field.

No application instances of this type

Mo application instances of this type

Refrigeration Summary

17.0 PSI 5.0 PSI NONEES o
51.0PS1  50.0PSI noNERS .
§3.9PS1  5A.0PS MBLE e Override

Display Leg Graph
Graph Collection 3

Show on Real-time Graph

LT Point Properties
COMDY RTC
COMDY R A Connection Verification Report
COMDENSER B

Forward Advisories

View Advisorizs

Create Setpoint Broadoast
Configure Advizary Snoozs
Configure CB Maintenance
Configure Log Purge

lication Instance

K LT/TC LTEB DT

K LT/TC
RAK LT/TC ME!

1 [ e

RAK LT/TC LTEA DT MEAT

K LT/TC LTEC DT MEA]

oK
oK
oK
oK

S

dxdddd
=]

7.5 OF
42.7 BF50.0 °F

Figure 5-1 - Refrigeration Summary

Graphical Screen
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5.3 Override Point

You can override input points and output points from a graphical screen. When you right-click on point value, you will see
Override in the right-click menu. To override, enable the Override check-box.

If you enter Fixed and a value, that point value would be overridden permanently until further changes are made.

Refrigeration Summary

Ne application instances of this Lype

RACK LT non Ef 4 100.0 %  OK
RACK TC NON Ef 2 100.0 %  OK
FROTOCOL A NON Efg & 100.0 % 0K
FROTOCOL B noNEfS & 50.0%  OK
Override
FILTERED PRES

g 72 Fan(s) On

20| Override v 72 F,...;a; g..

17 . = v ¥? anis) On

Type: =g ?? Fan(s) QI

Walue: 20.0 LR Fan{s} OI

e Per Square Inch

Motz

Mo application instances of this bype m n

z Fro

REF
R

R~ AK LT/TC LT3 RI FROZ FD RI

RS Ri

RS LTS RI FROZ FD Ri

RX- AK LT/TC LTE MD FROZ MT RI

R¥-4D0 2: RAK LT/TC LT7 RI FROZ FD RI ATION -0.2 9F 0.0 OF

Figure 5-2 - Fixed Override Point

If Timed is selected, you must enter a time in the field. A point value will be overridden for a time period as specified
after you click OK. The point of Site Supervisor only supports the Timed override.

Refrigeration Summary

Ne application inst

RACK LT of It PslI 1 4 oK
o PSI 2 2 oK
r 150.0 PST 6 & oK
or MErst 4 s oK
Override

FILTERED PRES

20 Cwerride ol 77
3 Type: T 2
15| Time:
Value [200

Pressure Per Square Inch

Note:

No application instances of this type

Figure 5-3 - Timed Override Point
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You can also override a point from the Navigation Tree or Watch Point List (covered in next section):

3 (® Outputs B
Watch Or Graph Points
[]  acTive npuT
[l assmms Display Log Graph Retrieve Logs + Graph Retrieve Logs Retrieve Logs + Export
1 num weus on NOTE: Only the first 15 points will be used on the graph
[l auteur
o I Params ¥ 1. HVAC/LTS/Air Handlers (AHUS)/1-MAIN AHU/Outputs/SPACE TEMP OUT
¥l 2. HVAG/LTS"/Air Handlers (AHUS)/GMI-SALES AREA/Output
Override override
ACTIVE TNPUT 4 3. HVAC/LTS'/Air Handlers (AHUS)/RTU-1 BAKERY/Outputs/S| SPACE TEMP OUT
¥} 4. HVAC/LTS/Air Handlers (AHUS)/RTU-24 PRODUCE/Output{
v i 9
Overrice #) 5. HVAC/LTS"/Air Handlers (AHUS)/RTU-28 PRODUCE/Output] %%
Type: | Foeed v Type:
Value: |0 ¥ &, HVAC/LTS'"/Air Handlers (AHUS)/RTU-3 KITCHEN/Outputs/! Time: 0:00:00
ot ¥ 7. HVAC/LTS'/Air Handlers (AHUS)/RTU-4 CONF RM/Outputs/| Value: NONE
¥) 8. HVAC/Air Handlers (AHUs)/RECEPTION AREA Degrees Farenheit
m “ #| 9. HVAC/Air Handlers (AHUs)/REFG LAB/Outputs Note:
v :
3 L]Frer 10 HVAC/Air Handlers (AHUs)/SIDNEY CONF RM
o Pl tachine ¥ 11 HVAC/Air Handlers (AHUS)/IT STORAGE/Outputs

Figure 5-4 - Watch or Graph Points

5.4 Modify Points

You can modify parameter points from a Graphical Screen.

= []urt groc
H @ Inputs
@ @ Outputs
3 = Params
|_| Case Alarm Hi
|_| Case Alarm Lo

Modify Setpoint
Case Alarm Hi

Value: 40.0

Degrees Fahranheit

| Case Ntc Prior

[T case Tune

Figure 5-5 - Modify Parameter Points

(3 Refresh | active points | @ @ (O Advisories File

e

= [3 circuits (standard) @ @

= [l sroc
# & Inputs
2 @ outputs Watch Or Graph Points

= B Params
[ Case Alarm b Display Log Graph Retrieve Logs + Graph Refrieve Logs Retrieve Logs + Export

Site Directories / Watch Or Graph Points

Cleaning Switch
Edit Application Instance

Comb Alarm Hi

Comb Alarm Lo

m|
O
[[]  case alm Hyst 7 e Modify .
U y . /Demo/154 Atlanta/E2/"RX-400 2: RAK LT/TC"/C s/Case Alarm Hi
[l case alm Prior Point Properties
O cose lrm Deley - CannestionVerifeation Répor m S L WOtk Pomts
[[] case Ntc Delay Forward Advisories .
. lect list... |
[]  case NtcHi View Advisories
[ casentclo Notes: Configure Advisory Sncoze
M B
tl | Gab e B Disabled point names indicate points which only have lc  Configure CB Maintenance ues.
M
Case Type
;_: i List Power Builder Configure Log Purge
O
M
O
M
O
=
=]

Comb Alm Hyst

Figure 5-6 - Case Alm Hi
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5.4.1 View Real Time Graph

While you can view point log graphs from the Advisory View, Advisory Email, Watch Points, and Graphical Screens, you
can only view point real time graphs from graphical screens.

The Real Time Graph allows you to watch the point value change in real time for different time intervals from five (5)
minutes up to one (1) hour. You can also add more points from the graphical screen to the real time graph by right-clicking
the point value. The point path will be displayed in the real time graph.

43 minutes
1 hour

2020-04-25 21:38:25
Show Expanded Legend

1

LL i 154 Atlancs/LT1 GROC/CONTROL TEMB
55°F

& [gl5% Atlants/LT2 RI FROZ FD/CONTROL
O Bz

& l5Atienta/LT4 RI FROZ FD/CONTROL
© Wy

Show full path goint list

Figure 5-7 - Real Time Graph

5.5 System Summary Screen

Tree Level Name Description
. . Include critical points from Suction Group, Condenser, and Case

Refrigeration Summary

Controllers
Site Buildine Summa Include critical points from Outside/Inside Temp and Humidity,
& vy AHU Temp and Status, Lighting Status and Schedules

Include critical points from Anti-Sweat, Demand Control, Power Channel,

Other Summary

Analog Sensor, and Digital Sensor

Table 5-1 - System Summary Screen
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Tree Level Name Description

Sites that usually have multiple controllers:

* Building Controller Summary is a subset of Site Building Summary
Unit Controller Summary for that specific controller.

* Ref Controller Summary is a subset of Site REF Summary for that
specific controller.

Include critical points for the below Application Types:

Circuits and other Case Controllers, Condenser, Suction Group, Physical
Summary AI/DI/DO, Sensor Control AV/DV, HVAC Zone, Lighting Control, Power
Monitoring, Anti-Sweat, Analog Combiner, Digital Combiner, Flexible
Combiner, and more.

App Type

Defrost Summary Only applies to Case Controller Application Types

Include critical input, setpoint and output points properties for application
Status instance. Only Application Instance from an Application Type that has

Summary Screen will have Status Screen. (See App Type->Summary)
App Ins

Can be found in Application Instances from AHU, Condenser, Circuits,
Graphical Summary Suction Group, Sensor AV/DV for graphical presentation of the physical
device.

Table 5-1 - System Summary Screen

How to Read Summary Screens

Each Summary comprise several tables. Table header is defined as:

“Controller Name”  “App. Instance Name” Point Value Point Value Point Value

As you can see from the example below, each table header has Unit as fixed header, with different Application Types such
as Enhanced Suction Group, Condenser, Circuit (CC) and Circuit (Standard). For each Application Type, point is also
different.

Controller Name/App. Ins. Name

Summary Table Header Unit/Application Type Name

Mo application instances of this type

333333
ARAAN

- .
333333
ARAAAD

Figure 5-8 - Read Summary Screens
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5.6 View Customized Screens

Your organization Admin, Service Provider, or Emerson Project Team might have developed customized screens to
match your requirements. Connect+ Graphical Screen Tools provide different image libraries and widgets to allow vivid
visual presentations of your store to be created.

You can view store floor plans as indicated below, or pull data from several stores to compare Food Safety Setpoints. Talk
to your Admin, Service Provider, or Emerson Project Team about what is right for you. You can set customized screens as
a Homepage or Site Homepage for quicker access.

Figure 5-9 - Customized Screen
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6 Watch and Graph Points

6.1 Watch Points

When you click the Watch Points icon, you will be directed to Watch or the Graph Points page.

Watch Or Graph Points

Select points to watch or graph by using the checkboxes in the tree.

Load Selection from list
Notes:

Disabled peint names indicate points which anly have logs and cannot retrieve real time values.

List Power Builder

a list.

Select Points to Watch From the Tree

Load Points From a List

Watch Or Graph Points

Select points to watch or graph by using the checkboxes in the tree.

Load Selection from list | ...

..zelect list...

You can select points to watch or graph using the check-boxes in the tree. Or load points from

ist.
AHU List
Notes: REF Baints

Disabled peint names indicate points which anly have logs and cannot retrieve real time values.

List Power Builder

»
~
EMERSON

(3 Refrash | pcovepors v | (@) @)

2w Damo
+ i 00211
& i 0219 Xizn
o
# i 100 Kennesaw
# 152 Lab
< i 154 Atlanta
IRE2
@ [ BX-400 1: HVACATS
2 Bl Rx-400 2: RAK LT/TC

3 [3 Circuits (Standard)

af:

3 B Inputs
[l case TENR L
[#|o case TeMR STPT
[ EMERGENCY OVR
LEAD CIRCUIT
BRI DEMAND SHED
SEC DEMAND SHE
START DEFROST
# @ outputs
@ [ Params

4 {3} Virtual hi

»
~
EMERSON

) Refresh | Active Points v (-]

= m Demo =
= i 00211
& i 0219 Xian
e
& iy 100 Kennesaw
& 152 Lab
= i 154 Atlanta
SfE
o [ BX-400 1: HVAC/LTS

< [H Circuits (Standard)

afdL

2 @ Inputs
[#| caseTEMP 1
[]| ./ cASE TEMR STET
[ eMErcEncY ovR
LEAD CIRCUTT
PRI DEMAND SHED
SEC DEMAND SHEI
[ START DEFROST
# (@ Outputs
3 B Params
£ Virtual b

Watch Points
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In the example below many points are contained in the review area. Click Watch Points at the bottom right corner.

¢ 75, BX2/Air Handlers (AHUS)/ NORTH DEH/Outputs/SPACE TEMP OUT
) 76. BX2/Air Handlers (2HUs)/ SALES/Outputs/SPACE TEMP OUT

¥ 77, BX2/Air Handlers (AHUS)/ STOCKROOM/Outputs/SPACE TEMP OUT
< 78. BX2{Air Handlers (4HUs)/ BREAKROOM/Outputs/SPACE TEMP OUT

|AHU List

Load Selection from list [ AHU List

Delete List

+Bublic List

Watch Points

Figure 6-1 - Click on Watch Points

Wait several seconds for Connect+ to establish the real time communication to your controllers. You will see the value

change from “?” to meaningful values.

3 1 Circuits (Standard)
a0
2 8 Inputs
[#| . case TEMR 1
[ case TEMR STRT
[ emercEncY OVR
[ t=ap crreurT
[[] PRI DEMAND SHED
[ SEC DEMAND SHEL
[ sT2RT DEFROST
3 (@ Oupus
# I Params
@ i Virtual
3 [IFrRozZ FD
2 ) Inputs
[F| casE TEMP 1
[ caseTemp sTRT
EMERGENCY OVR

Site Directories / Watch Or Graph Points

watch Or Graph Points
p—— T prer—— N

@ 1. HVAC/LTS"/&ir Handlers (AHUS)/1-MAIN AHU/Inputs/COOL PROOFL
@l 2. RAK LT/TC"/Circuits (Standard)/Inputs/CASE TEMP 1

# 3. RAK LT/TC"/Circuits (Standard)/Inputs/CASE TEMP STPT

@l 4, RAK LT/TC"/Circuits (Standard)/Inputs/CASE TEMP 1

# 5. RAK LT/TC"/Circuits (Standard)/Inputs/CASE TEMP STPT

Load Selection from lise [___select list.. v

Motes:

Disabled point names indicate points which only have logs and cannot retrieve real time valuss.

-
=

-12.00F
i3]

0.00F

Stop Watching

List Power Builder

BRI DEMAND SHED

o
[0 weap crrcurr
o

Figure 6-2 - Click on Watch Points

6.2

What Else You Can Do With These Points

In the Watch or Graph Points Page, besides the Watch Points’ real value, you can also:

* Display Log Graph, Retrieve Logs and Export for multiple points selected.

 Right-click on each point to access Display Point Graph, Real Time Graph, and View Advisories.

Watch Or Graph Points

[ osvior oncrepn | netrveroos +croph | nenevetogs | metnevetons +expere ]| oo |

. HVAC/Air Handlers (AHUs)/IT STORAGE/Outputs/SPACE TEMP OL”
. HVAC/Air Handlers (AHUs)/RECEPTION AREA/Outputs/SPACE TE!
. HVAC/Air Handlers (AHUs)/REFG LAB/Outputs/SPACE TEMP OUT

. HVAC/Air Handlers (AHUs)/SIDNEY CONF RM/Outputs/SPACE TE!

1

2

3

4

5. PALO Cx=1/Air Handlers [AHUs)/AHU1 MainSales/Outputs/SPACI
6. PALO CX=1/Air Handlers (AHUs)/RTU1 Front End/Qutputs/SPACE
7. PALO CX=1/Air Handlers [AHUs)/"RTU2 Officer/C"/Outputs/SPAC
B Large/Air Handler_001/0urputs/SPACE TEMP QUT

9. : HVAC/LTS"/Air Handlers (AHU=)/1-MAIN AHU/Outputs/SPACE TE
HWVAC/LTS"/Air Handlers [AHUs)/GMI-SALES AREA/Outputs/SPi
HVAC/LTS"/Air Handlers [AHUs)/RTU-1 BAKERY/Qurputs/SPACI
HVAC/LTS"/Air Handlers [AHUs)/RTU-2A PRODUCE/ Outputs/SB

A AR ANARARAMNEAREARRR

HVAC/LTS"/Air Handlers (AHUs)/RTU-28 PRODUCE/Cutputs/SP

NOTE: Only the first 15 points will b used on the graph.,

Overmride

Show on Real-time Graph

Point Properties

Connection Verification Report
Forward A

View Advi

Create Setpoint Broadoast
Configure Advisory Snooze
Configure CB Maintenance
Configure Log Purge

Edit Application Instance

Figure 6-3 - Other Points
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6.2.1 Display Log Graph
We have introduced how to read log graph in the Advisory View session. You can also choose to Display Log Graph
from Watch Points.

 If you want to see an alarming point’s log graph, right-click on the point name and choose Display Log Graph.
The log graph you see is the same as the one you see from the Advisory View.

 If you want to see multiple points’ log graph, just click Display Log Graph, all selected points’ log graph would
be shown for the same time period.

4H 12H 1D 2D 4D 1IW 4w

s [ ) O E S

On

=
2
S Off,
15:00 15:30 20:00 20:20 21:00 21:30 22:00 22:30
§ 154 Atlanta/1-MAIN AHU/COOL PROOFL
*
s 5
-ooe L 2]
-15
20:30 21:00 21:30 22:00 22:30

@ Atlanta/ FD/CASE TEMP 1
== [ 154 Atlanta/ FD/CASE TEMP STPT (no log in controller)

Figure 6-4 - Display Log Graph
6.2.2 Retrieve Logs
If the points you selected do not have logs retrieved, consider retrieving logs first and then displaying the log graph.

When you Retrieve Logs, Connect+ will display the Activity progress:

Retrieve Logs From List
In Progress 62%

Target : Directory Multigle
Started 4/25/20 10:53 PM

Duration 2 s=conds

StartMethod On Demand

Hide Details

User

Calculating Execution Data...
Processing 5 points...

Done processing paints.
Starting on Directory Dema

Figure 6-5 - Retrieve Logs
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Upon completion, you can go to the Header Menu > Activities > View My Activity History to check the Retrieve Logs

status.

My Activity History - Results

Occurrence Date Past 7 Days v

(*Reset Filters 3 Refresh Activity History
Activity Started »

1= Logs From List | ¥

+ FEtrlE e Logs F'cm List 4/25/20 B:25PM

@ Retrieve Logs From List 4/25/20 B:24 PM

Duration

00:00:02

00:00:02

Terget

Multiple

Multiple

Show |25 ¥

Result Exceptions Report

o complered

o complered

Figure 6-6 - Retrieve Logs

6.2.3 Export

You may also want to export log data for these points. Click Export, fill the time range and click Go. Export will be in
progress. Upon completion, an Excel file will be downloaded to your computer.

From [2020-04-24 00:00:00 | (@ To[2020-04-26 23:59:59

& Time Perspective: | Site Time

R [ T ) S
-

File Type: | Comprehens

Figure 6-6 - Export
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7  Access Control

Monitoring your store from an Advisory Map, Graphical Screen, or Watch Point Lists may not always be sufficient.
Connect+ allows you to connect to your controller remotely to access the controller to change settings or get more

information.

7.1  Terminal Mode

You can remote login to Terminal Mode. You can access Terminal Mode from two places: Right-click menu at the
controller level or from the Advisory View controller link.

> €

& connectmyproact.com/demoyserviet/HTTPSessionProxys

Site Supervisor - Google Chrome

) Refresh | Accue points

Refrigeration NONE * 34.00"

B ®

o Helx Gaorgia Tach

Kennesaw Circuits (Standard)

Refrigeration NONE " -7.00"

B @

e Supaiser
-
am Kennesaw

Circuits (Standard) | Kennesaw

Copyright 2020 © Emerson

A
@ [ Rc300 4: E2 53 -
5155 0fendo meson € B M C W O B
B
& 2w System Summary
# 4t 250 Wake Forrest
#1252 Tybee ~ | 3 Refrigeration (20)
5 # 54 Charloe
Sl Tes
5 &L Bary's Offce prY— Em—p——— T P ———
@ QPRe300 1 2 Refrigeration 83.00" 34.00" | Refrigeration NONE™ 34.00 ™
o ) e (%
& # DemoSitsTast A% G @
SR St Sumamisor K Circuits (Standard) Circuits (Standard)
Sass
S ]
5 i eix

Refrigeration NONE ™ 34.00"

@
Circuits (Standard)

Refrigeration NONE™ -7.00"

@
Cireuits (Standard)

cRcuT sTaTE

Refrigeration NONE ¥ -7.00

Kennesaw

Refrigeration NONE ¥ -7.00*

‘Circut 03 Cooler @

aRouT sTaTe

Refrigeration NONE * 34.00™

CONTROLTEMP ACTIVE SETPT

Circuits (Standard)

CONTROL TEMR ACTIVE SETRT

B ®

Circuits (Standard)

= ®

ennesaw Circuits (Standard)

Site Supervisor  SF 2.13F01

Figure 7-1 - Terminal Mode

7.2 Controller Logs &
Stats

You can also view Controller Logs & Status from the
right-click menu at the controller level. Below is a list of
Controller Logs & Status Reports you can view directly
from Connect+:

* Monitor Master

* Monitory Relay

* Check Status Usage

» Communication Statistics

* Schedule Statistics

* CPU Usage Report

* Description File Report

* Free Memory and Disk Space
* License Report

System Logging Report
Task Details Report
Task Statistics

Assertion Log
Exception Log
Maintenance Log
Monitoring Connection Log
Monitoring Log
Monitoring Pending Log
Override Log

RMS Log

Service Log

Stpt Change Log
System Update Log
User Access Log

Terminal Mode
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Controller Logs and Stats

Type of diagnostic information: \Communication Stati

=
‘Communication Statistics- 05/01/2020 - 20:55:44 - Rev: 3.09F04
RS-232 Direct Serial (0OM1):
Total sent: 0
th a NAK response: 0
th no response: 0
Total recai 0
r checksum) emror: 0
th format errors:
RS-485 IONet (COMZ)
Total sent
Total : 1
0 0.00%
73514 100.00%
Average Response Time {ms):  99.16
No Response 275 100.00%
Received MAK : o 0.00%
Checksum Error: o 0.00%
Format Error : 0 0.00%
Total Totzl R Rece No Average
Name  Sent ed Successfu With Errors  Response Response Time (ms)
16AI-1 o 0.00% 19677 100.00% 19677 100.00% 102.96
16AI-2 1] 0.00% 19677 100.00% 19677 100.00% 102.89
1B6AI-3 o 0.00% 19677 100.00% 19677 100.00% 939.64
16AI-4 o 0.00% 1%677 100.00% 19677 100.00% 94.84
16AI-5 o 0.00% 1%677 100.00% 19677 100.00% 94.75
1EAI-6 o 0.00% 1%677 100.00% 19677 100.00% 99.54
8RO-1 o 0.00% 19880 100.00% 19680 100.00% 101.26
S8RO-2 19680 19680 O 0.00% 19680 100.00% 19680 100.00% S2.71 -
ERO-3 19680 195680 o 0.00% 19680 100.00% 19680 100.00% 96.30

Figure 7-2 - Controller Logs and Stats

7.3 Network Status

You can view Network Status from the right-click menu on both the Control System and Unit levels. Network Status
provides real time controller/device connectivity. You can view if a controller or a device is online or offline from
Network Status screen.

Network Status

(*Reset Filters €3 Refresh

EIE Device Mame « Davice Type Protocol Address Port Revision Status Parent Unit

8 RAK LT/TC-Gateway RX-400 ernet 2 3.05F04 Online RAK LT/TC
- E2 Unit04 RX-300 ernet 4 3.05F04 Online RAK LT/TC
- HVAC/LTS Bx-400 Ethernet 1 3.05FD4 Online RAK LT/TC
- LT-8D0=1 800 IONet 1 IONet-1 0.00 Offline RAK LT/TC
- LT-8RO=6 8RO IONet 6 IONet-1 0.00 Offine RAK LT/TC
- LT-8RO=7 8RO IONet 7 IONet-1 0.00 Offline RAK LT/TC
- LT-8RO=8 8RO IONet g IONet-1 0.00 Offine RAK LT/TC
- LT-8RO=9 8RO IONet El IONet-1 0.00 Offfine RAK LT/TC
- LT-16AI=4 16AI IONet 4 IONet-1 0.00 Offline RAK LT/TC
- LT-M16I=1 16AI IONet 1 IONet-1 0.00 Offfine RAK LT/TC
- LT-M88I=2 16AI IONet 2 IONet-1 0.00 Offline RAK LT/TC
- LT-M88I=3 16AI IONet 2 IONet-1 0.00 Offline RAK LT/TC
- LT-MB8I=5 16AI IONet 5 IONet-1 0.00 Offine RAK LT/TC
- LT-MBEI=& 16AI IONet 6 IONet-1 0.00 Offline RAK LT/TC
- LT-M880=1 8RO IONet 1 IONet-1 0.00 Offine RAK LT/TC
- LT-M880=2 8RO IONet 2 IONet-1 0.00 Offline RAK LT/TC
- LT-MB80=3 8RO IONet 3 IONet-1 0.00 Offline RAK LT/TC
- LT-MB80=4 8RO IONet 4 IONet-1 0.00 Offline RAK LT/TC

Figure 7-3 - Network Status
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8 Controller Activity

We have covered Point Level Activities such as Override/Modify, Display Log Graph, Real Time Graph in Advisory,
Graphical Screen & Watch Point Session. This session will cover Controller Activities from the Navigation Tree

right-click menu.

8.1 Manual Defrost

Manual Defrost allows users to start a defrost for a freezer or refrigerated case that is outside its normal scheduled routine.
Manual Defrost is available only for supported controllers (E2 and Site Supervisor) and applications (Standard Circuits,
Case Control Circuits, XM Circuits and MultiFlex CUB).

To start a manual defrost, right-click the application instance (circuit) where the freezer or refrigerated case to be
defrosted is associated, and click Manual Defrost.

LT1 GROC
ts v
¥ Modified Circuit Screen
2] Graphical Status
Status
Manual Defrost ‘
Views b
Configure b
File 2
Activities 2
Advisories b
TS
Setpoints b
TC
Food Quality b Setup
CB Maintenance b
Refrigerant b |ard)

a FliT4 ~nne

Figure 8-1 - Manual Defrost

The Manual Defrost box will appear with the name of the application instance displayed.

a
=
EMERSON

() Refresh | active Points )

= Il Demo

= 00211

= 0218 Xian

21

= i 100 Kenn Manual Defrost

S 152 b LT1 GROC

24 154 Atlan{ ¥ In Bypass

3 &E2 Type[Defost v

2 B &

 [3 Alarm/Advisory Setup
& [3 Anti-sweats
= [3 Circuits (Standard)
@ F1ur1 6ROC
@ []ir2 R1FROZ FD
@ []i3 r1FROZ FD
@ []ira r1FROZ FD
@ []u7s r1FROZ FD
& [1176 MD FROZ MT
@ []ur7 r1FROZ FD
& []LTsa OT MEAT =

({) Views Advisories Setpoints Food Quality

“| site Directories / ctivities / Admin Activity History

Activity History - Results

Oceurrence Date | Past 7 Days

(Reset Filters €3 Refresh Activity History

Activity Started v Duration

Manual Defrost | ¥

No activities to display

CB Maintenance

|4 4 |pagels ofi| » M| G

Refrigerant

Target

File

Result

Al

Show[25 ¥

Exceptions Report

No activities te display

Figure 8-2 - Manual Defrost with Application Name

Manual Defrost
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Once set, the manual defrost command is sent to the controller. Details of the Manual Defrost activity (whether
Completed or Failed) will be recorded in the Activity History page.

Activity History - Results

Qccurrence Date | Past 7 Days v

(Reset Filters €3 Refresh Activity History
Activity Started = Duration User

Manual Defrost | ¥

% Manual Defrost 5/3/20 10:10 AM 00:00:01 Fan

Get Manual Defrost Types 5/3/20 10:07 AM 00:00:00 Fan

Show|25 ¥

Target Result Exceptions Report

All 2

LT1 GROC ¥ _Completed

LT1 GROC ¥ completed

Figure 8-3 - Activity History Results

When Bypass is selected, a drop-down list appears and

contains different types of Manual Defrost to choose from:

a. Defrost - Puts the unit in its normal defrost
routine.

b. Emergency Defrost - Begins defrosting
immediately. This event continues until the
bypass is removed.

c. Start Cleaning - Starts the clean or wash mode.
Refrigeration cycle ends without any defrost
action. The normal time programmed for
cleaning mode also applies.

d. Refrigeration Override - Appears only if the
Application Instance is a MultiFlex CUB
application.

A message displays if the Application Instance on which
Manual Defrost is being run does not have data in the
database. In this case, run a Refresh Point List first and
configure the manual defrost again. See the Refiresh Point
List section on page 39.

8.1.1 Refresh Controller &
Application
Obtain Controller Information

The Obtain Controller Information activity connects to a
given Control System, refreshes the Unit list, refreshes the
Application List for each Unit, and refreshes the points for
any Application Instances that have “out of date” points,
which means the point list will be retrieved for any
applications that have never had a point list retrieved, and
also for any applications that have changed since the last
time the point list information was checked.

Obtain Controller Information will need to be run (or
equivalent operation) for Connect+ to display the current
information in the controller and synchronize the updates
from the controller configuration and the GS Screen. Note
that if the configuration of the controller changes while a

GS Screen is being viewed, the system will not pick up
configuration changes between the time the application
data inventory is being received.

Refresh Unit

Refresh units is an activity that may be performed at the
control system level. When a Refresh Units is performed,
information is pulled from the controller and is posted to
Connect+.

Right-click on the desired Control System from the main
Navigation Tree to bring up the pop-up menu and select
Refresh Units. Once this activity has been triggered, the
Activity Status page will be displayed.

Refresh Application

Right-click on the desired unit from the main Navigation
Tree to bring up the pop-up menu and select Refresh
Applications. Once this activity has been triggered, the
Activity Status page will be displayed.

When the activity has completed successfully, the
changes, if any, will be evident automatically on the
Navigation Tree under the selected unit or click the
Refresh button in the navigation frame.

Refresh Point List

Refresh Point List is an activity that may be performed
only at the Application Type and Application Instance
levels on the Navigation Tree. When a Refresh Point List
is performed, information is pulled from the controller and
is posted to the database.

Right-click the desired application type or instance from
the main navigation tree to bring up the pop-up menu and
select Refresh Point List. Once this activity has been
triggered, the Activity Status page will be displayed.

When the activity has completed successfully, the
changes, if any, will be evident automatically on the
Navigation Tree under the selected application or click the
Refresh button in the navigation frame.
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8.2  Schedule Controller Activity

When you perform an activity from the Navigation Tree/Graphical Screen/Watch Point right-click menu, you start a
Run Once activity. You can also schedule a recurring controller activity from the top Header Menu > Activity. You can

add a new Schedule by accessing Schedule Manager > Add New.

8.2.1 Add aNew Schedule

Activity Startup

® Run Now Run On Schedule
Details
Type Retrieve Logs v

Configuration
Site Directories Get Logs By: ® Filtering Rules Lists General Points

Filtering Rules:

Unit Rules
#lzrm/#visary Setup Flexible Combinar General Satup Global Datz
Logging Groups Physical AT Physical DO Remete Dislout Setup
TRNBCI-RS Time Schecules Time and Date User ccess Levels

O 4 00211

]
8 O i 0219 Xian
8
]

23 O 4 100 Kennesaw
3O & suite 100
O B 1 Hvac
@ B 3: sumE 170

BB TarkSunnnr

HVAC Zones

Sensor Control DV

Figure 8-4 - Add a New Schedule

When adding a new schedule, you can choose Run Now. The activity would just run once.

Activity Startup

% Run Now Run On Schedule
Details
Type Retrieve Logs From List T

Configuration

Get Logs By: Filtering Rules ® Lists Generz| Points
All Lists
AHU List REF Points

Figure 8-5 - Activity Startup

You can also choose Run On Schedule and specify the days/hours that you want this activity to run.

Schedule Controller Activity
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8.2.2 Schedule Manager

Schedule Manager
All schedules are based on the server's time zon

{GMT -05:00) Eastern Standard Time

Run Mow i Run On Schedule

Details

FQR Datz Gathering v

Schedule

- (GMT -05:00) Eastern Standard Time - America/New_York (EST) (DST)

Run Once Interval Based # Calendar Based
Start Date/Time 05/01/20 9:28 PM b
End Drate/Time: 3 >
= Every Day Days of Week Days of Month
Hours 01234567851011 121314151617 1819 2021 22 23

Minutes

Notification

On Success 0On Unsuccessful

America/Mew_York (EST) (DST)

Figure 8-6 - Schedule Manager

You can view your Schedule in the Schedule Manager:

Schedule Manager

hedules 2re based onthe

Schedule Assistant Show System Schedules Show [25

_JAddNew Reset Filters

's time zone: (GMT -05:00) Eastern Standard Time

Name Type User Schedule
r -
C8 Maintenance jmitchell Every Day At 12:05 AM
FQR Demo FQR Datz Gathering engadmin Every Day At 2:20 AM
Setpoint Mgmt Setpoint Resolution administrator Every Day At 5:05 AM
M-Data Logs Retrieve Logs administrator Every Day At 7:00 AM
100 Knsw Energy Logs Retrieve Logs administratar Every Day At 7:30 AM
Loas Retrieve Logs administrator On Mon, Wed, Fri and Sat At 5:25 PM
Setpoint Resolution Setpoint Resolution dministrater On Tus & :40 AM
Indoor Modular Soln Whly Lo.. Retrieve Logs From List anichalsan On Thu In Apr, May, Jun and Jul At 10:00 P.
Backups Badap =dministrator On the 24th 0 Jan, Aps Jul 2nd Oct At
Retrieve Logs From List jmitchell Every Day At Many Different Times
Power Monitoring Retrieve Logs jmitchell Every Day At 7:00 AM
advisary Manthly Repart Reparting - Emailing engadmin One Time Only
Kathy test Backup khart One Time Only
KHart Test Refresh Point List khart One Time Only
Sample AHU KT Setpoint Broadeast jmitchell One Time Only
H 4 |Page: ofi| B M| &

Next Run Time «

0 12:05 AM

) 2:20 AM

) 5:05 AM

Last Run Time

0 12:05 AM

0 2:20 AM

0 5:05 AM

0 7:00 AM

0 7:30 AM

/20 5:25 PM

Last Status

Al

® partially Completed
W rzrally Complarad
B exrvally Compler=d
X railed

¥ Complatad

¥ Complated

B pxrvially Compler=d
+ Completed

& Completed

X railed

® partially Completed
 Completed

X railed

' Completed

¥ Complated

Displaying Schedules 1 - 17 of 17

Figure 8-7 - View Schedule
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8.2.3 Schedule Assistant

Schedule Manager
Al schedules =re based on the server's time zone: (GMT -05:00) Ezstern Standard Time - America/New_Yerk (EST) (DST)
Summary
Schedule Assistant
« 2| Apr 26 - May 2 2020 m Nzme Type [l v user Status [ Al v ﬂ
Sun 4/26 Mon Tue 4/28 wed 4/29 Thu 4/30 Sat3/2
12am
1am
Za
FQR Demo FQR Demo FQR Demo FQR Demo FQR Demo FQR Demo FQR Demo
Sam | Engadmin engadmin engadmin enaadmin engadmin - engadmin
Zam
5am
£am
7am |[HFData M-Data M-Data M-Data M-Data M-Data M-Data Logs
- 100 Knsw | |~ 100 Knsw |~ 100 Knsw |~ 100 Knsw |~ 100 Knsw | |~ 100 Knsw | administretor | 100 Knsw
8am - - - - - N Energy Logs
administrator
gzm
10am
11am
12nm

Figure 8-8 - Schedule Assistant

8.3 View Activities Status

You can check the Activity Status in Activity History whether the activity is started from any menu or if it is Run Once or
Run On Schedule. You can access Activity History from the top menu or right-click menu at each Navigation Tree Level.

My Pending Activities - Results

Show |25 v
O Reset Filters {3 Refresh Pending Activities
Activity Requested to Start v Target Status
Al v Al hd
Terminal Mode 0 8:58 PM
t 7 Days v Show|[25 ¥
(CReset Filters 3 Refresh Activity History
Activity Started w Duration User Target Result Exceptions Report
Al o Al v
5 Get Point Values 00:06:15 switch switch AM
# Get Point Values 00:06:15 switch switch
 GetPoint \: 00:06:15 switch switch
# GetPoint \: 00:06:10 switch switch
+ frash Point List /20 9:12 PM 00:01:20 Fan
+ fresh Applications 0 9:12 PM 00:00:04 Fan
4 GetPoint Values 00:06:55 switch switch
@ Terminal Mode 01:08:06 Fan
@ Initializing Terminal Mode 00:00:01 Fan
% Get Dizgnostic Information 00:00:01 Fan BX-400 1: HVAC/LTS
% Get Disgnostic Information 00:00:00 Fan BX-400 1: HVAC/LTS
B agnostic Information 00:00:00 Fan
® Get Diagnostic Information 00:00:02 Fan
m Get Disgnostic Information 00:00:02 Fan ' Completad M
14 4 | Pagel f23 Displaying activities 1 - 25 of 1250

m
Expore [Not Complered .

Figure 8-9 - Pending Activities
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Field Name Description

An activity includes all system and user-performed activities in Connect+. You may see some activities you
Activity that may not have been performed, such as Get Point Value. These activities can be called by other activities
that have been performed such as Retrieve Logs.

Started Time when the activity has been started

Duration How long it takes Connect+ to perform the activity

User Who performed this activity

Target Directory/Site{Cpntrgl Syster‘n/Units/Application Type/Application/Points ***see below explanation for
compound activity with multiple target

Result In Progress, Complete, Partial Complete, Fail ***see below explanation for Partial Complete

Exception Report When activities are partially complete or have failed, this report will include the reason for diagnosis.

Table 8-1 - View Activities Status

Tips: Certain Activities are compound activity. For compound activities, you can expand the parent activity to check each
children activity’s Target and Result. For example, Obtain Controller Information is an activity that contains Refresh
Units, Refresh Application, and Refresh Point Lists. If you start Obtain Controller Information at the Directory Level, it
would then apply to any site and controller. You would see and expanded list of sub-activities with Targets and Results. If
any sub-activities have failed, the parent activity Result would be partially complete.
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9 Global Search

A search can be performed by entering criteria into the search field (look for the magnifying glass) on the Connect+
header. You can search for a site’s home screen, or for a specific directory, sites, controller, devices or points.

Figure 9-1 - Search Field
When a site is configured as the Site Home Screen, you can search the home screen by filling in the site name.

If you do not click the search button and wait for the site’s home screen name to show up like a drop-down item, by
clicking the site home screen name, you can be directed to that site’s Home Screen directly.

Norma! Retrgerstion
Demost

atarm

Figure 9-2 - Site Home Page

e R

@ Advisories  Setpoints  Food Quality CB Mai Energy i i File
Search Resuls Relevance I i (0.0 0
[ame [Type [Context

Condensers Application Type = Demo > 162 > E2 > RX-400 4: LT DESK > Condensers
Condensers Application Type > A_Kennesaw TechSupport > 55 > E2 > RX-400 2: E2 UnitD2 > Cendensers
Condensers Application Type > H > 00238 = E2 > RX-300 1: RACK A > Condenszers

Condensers Application Type >H > 00238 > E2 > RX-300 2: RACK B » Condensars

Condensers Application Type * H > 00258 = E2 > RX-300 3: RACK C > Condensers

Condensers Application Type = Deme > 154 Atlanta > E2 > Ri-400 3: PROTO A/B > Condensers
Condensers Application Type = Demo > 154 Adznta > E2 > RX-400 2: RAK LT/TC > Condensers
Condensers Application Type > M > MO02%6 > E2 > RX-400 2: RACK 1 > Condensers
Condensers Application Type > M > MO0296 > E2 > RX-400 3: RACK 2 > Condensers
Condensers Application Type = M > M00296 > E2 > R¥-400 4: RACK 3 > Condensers
Condensers Application Type = M > M002%6 > E2 » R¥-400 5: RACK & > Condensers
Condensers Application Type > M > M00296 > E2 > RX-400 6: RACK 3 > Condenszers
Condensers Application Type = M > MO02%6 * E2 > RX-400 7: UNIT 6 > Condensers
Condensers Application Type » M > M0O0120 > E2 > RX-400 1: RACK 182 > Condensers
Condensers Application Type =M > M00120 > E2 > RX-400 2: RACK 384 > Condensers
Condensers Application Type =M = M00120 > E2 > RX-400 3: RACK 5 > Condensers
Condensers Application Type > RX400-Refrig:LT DESK > Condensers
Condensers Application Type > Test > Fan Test > RX-400 2: RAK LT/TC > Condensers
Condensers Application Type = Test = Fan Test > RX-400 3: PROTO A/ > Condensers
Condensers Application Type > Test > Fan Test > RX-300 4: E2 Unit04 > Condensers

Figure 9-3 - Search Result
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10 View Enterprise Summary

If you want to have an overall understanding of your Enterprise Assets such as:
* How many stores do I have?
* How many controllers do I have?
*How many are building controllers?
*How many are Ref Controllers?
*How many are E2 and how many are Site Supervisor?
* How many Case Controllers do I have?

* How many Rooftop Units do I have?

The Enterprise Summary in the toolbar menu is the right place for you to find these answers.

You can view the Enterprise Summary from a Directory to Application Instance. Each contains different information.

Enterprise Summary
Show[25_ ¥
View By: | Directory  Site  Conbrol System @ Unit | Applicaion Type | Application Instance O Reset Filters
Urit Directory Site Control System v Model and Series ~ Controller Version Gateway Number of Backups to Ke.. Number of Backups Impl.. Last Backup Time
4| Sert Ascending AL X [a]
XWES name Dema XnebEVD V.STANDARD 7 B}, Sort Descending Unknown - ]
EMERSON TEST Dema 54 Charlome XwebS00 2.2.1_05 Ver:2.0.0 Unkngun 4 ]
XiwebSO00EVO Dema XWEB EVC Fisra V.STANDARD 12 [E columns Pl @ unit ]
Jenny3 Dema EVO Dev Kb EVO V.STANDARD 10 br-2014.08 4] Directory ]
Jerny3 Dema XinebEVD Xiweb EVO V.STANDARD 10 br-2016.08 9] site o
US_1001_L Ben Air.. L 1001 X EVO v bre2014.08 ]
9] Control System
U5_1003_L Newpore. L 1003 Xweb EVO vt br-2014.08 o
US_1006_L_Suffelkc_ L 1006 Xweh EVO Vit br-2014.08 | Rl [
Lsbss 152 Bahams Site Test ox 2.14807 V| Conzroller Version 0
£2 Unit02 Dema 100 Kenneszwr TechSupport RX-400 2.09F04 ) Gateway 1 03/19/20 07:46 AM
52 Unito1 Supenvisor New Site sup Rxe 2,07F01 Monitaring Master o
SUITE 170 Dema 100 Kenneszwr Suite 100 BX-300 410701 ]
Annundiator
HuAC Dema 100 Kennesaw Suite 100 BX-400 «.03883 i o
Rack A Dema 250 waks Forrest 55 Peer = 212836 @] Number of Backups 1o Keep 2 09/11/1810:23PM v
U] Number of Backups Implementad N
4 paget 3 F MG || Emimepu Displaying items 1 - 25 of 208
S
x H|SES

Figure 10-1 - Enterprise Summary

With the Advisory View, you can sort, filter and add more columns for your review. You can also export to Excel, PDF or
HTML file types.

44 « Connect+ General User Guide 026-1020 Rev 2



11 Installing Custom Screens in Site
Supervisor

1. Log in to the Supervisor using a One-Day Password. Please send an e-mail to SolutionsTechSup@Emerson.com
for the password.

2. After logging in, click the Floorplan icon.

System Summary oor Pla Coliapse all | Expand ail

A ™ Refrigeration (5)

2 EVAPORATIVE CONDENSER @ -

NONE™ 125.00° Fan(s)On | NONE™ OF NONE™ 22.00° 2
A ' A

Condensers Analog Sensor Control Enhanced Suction

5 ACTIVE

ighting (0)
¥ Energy (0)
- o Other (14)

w  ilsystem(6)

Copyright © 2019 Emerson Site Supervisor Braemar CXe 2.08F01
3 8 s oneday @ 03/12/2019 06:19:31 PM

Figure 11-1 - Floor Plan Icon
3. Then click Go to install.

-
v e

Foorplan Install

No floorplan screen is installed
Go to install

Copyright © 2019 Emersan Site Supervisor Braemar CXe 2.08F01

oneday @ 03/12/2019 06:1%:51 PM

Figure 11-2 - Go to Install
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4. Click Install Floorplan button.

< c O

A Mot secure | filemanagement

EMERSON

o #®

File Management & Licensing - (00-0A-F&-8 1

< 2

o B M

2]

No Floorplans are instalied
Application Description & Service Files
B Name Of Application Description Version  In Use License Key
[ | CTMA0OVFD CT M400 VFD 10036 | 10f17 | 2944.9999-ADDA-2BF8 I:
o | combe sensor Vaisala Combo Sensor (GMWI0) 10022 |0of1 o
| ECB-D20 con Version 2 ECB-D20 10015 [ aof1 |
@ |Eo2 €D3 10001 | Ocf1
| GPLCM241 GPLC M241 801 10006 | 1ef1
o | eom GCIM CIU200 1000.1 .nnﬂ
| smart Defrost OpenFlex Smart Defrast Open Flex 0012 | 0of1
U | Subcooler Subcooler 124 Qof21
XCM25D_13_ZXLE XCM25D 1.3 ZX AU BO1 20056 | 0of3
XCM25D_V13 XCM25D_13 XFAL 10019 | 0of1

Copyright ©2019 Emerson

Site Supervi
day @ 03/1

r Braemai
6:20:1

Figure 11-3 - Install Floorplan Button

5. A window will pop out where users will have the option of getting the custom screen file from the local PC or the
controller’s SD memory card. For this example, click Local PC or other devices.

SRR & o o | lmmansgement

Install Floorplan
Install From @ Local PC or olher devices

Site Supcrvizor
O 8D Gard

Figure 11-4 - Install Floorplan Window
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6. Another window will pop out. This time, navigate to the location of the custom screen file. Highlight the file, and
click the Open button.

Nt secure | Hemansgement

nstall Floorplan

E West Airk Chillerzip

& Open
4 o OtherSercern » 8. Chowd
Orgize v Homfelder

Fame

# Ouick sccess
oialc

L ¥

& Downioads =

-
.
.
& pictures. .
01 Retail fobitiom &
. GSC Dietws Livary  #
|| EFS_Controliergackupl ¢

W
v ] ]

Fle name | West Rink Chiller :I [Cnmamsced (i ed) Toler

3

Figure 11-5 - Open Button
7. Click the Install button.

BW

A Notsscurs | filemanagement

Install Floorplan

Tl cruter zip

Figure 11-6 - Install Button
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8. Wait while the floorplan is being installed. Once completed, you may click the Ok button.

- @ Logout

Install Floorplan

No Floarplans are installed Floorplan has been installed successiully.
Application Description & Service Files
W Name Of Applicatian
CTM400VFD GLEE TS | oI | 2OL% 300 ADDAZErE. .
i@ | combo Sensor Vaisala Combo Sensor (GMWS0) w0022 | 0of1 I
@ | ECB-D20 con Version 2 ECBD20 10015 | 0of1
B | Ep3 ED3 1000.1 Ooft
| GCoalPLC M241 GPLC M241 BO1 10006 | 101
B | Gom GEIM CIUZ00 10001 | 0of1
i | smartDefrost OpenFlex Smart Defrast Open Flex 0012 | 0cf1
| Subcooler Subcaoler 124 aof21
W | XemM25D_13.ZXLE XCM25D T 3ZX AU BO1 20056 | 0of3
B | xeMz5D.V13 XCM25D_13 XFAL 10019 0of1

Figure 11-7 - OK Button

9. To access the screen, click the Floorplan button on the Main Menu.

System Summary b West Rink Collapse all | Expand ail

& ™ Refrigeration (5)

2 EVAPORATIVE CONDENSER @ - ||

NONE™ 17.00" 2 NONE™ 125.00° Fan(s)On | NONE™ OFF NONE™ 22.00° 2
A 2

Suction Groups Condensers Analog Sensor Control Enhanced Suction

ghting (0)
¥ Energy (0)
v o T (14)

w {1 System (6)

Copyright © 2019 Emerson Site Supervisor Braemar CXe 2.08F01
3 8 s oneday @ 03/12/2019 06:19:31 PM

Figure 11-8 - Floorplan on Main Menu
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10. The screen will then be shown.

Floorplan

CHILLER

BRINE IN TEMPo¥F
BRINE QUT TEMPou

TEMP SETPOINT 720 SUCTION PRESSURE povext

Nonewst

SUBFLOOR TEMP. NET QIL PRESSURE

LEAKLEVEL "™ | DISCHARGE PRESSURE Nk

AMBIENT TEMP O DISCHARGE TEMP i

Copyright © 2019 Emerson

wowEpst

wowEpst

wowes

2]

PLAN CHOOSER Install | Advanced

e Supervisor Braemar CXe 2.08F01
03/12/2019 06:24:21 PM

Figure 11-9 - Screen

11. Going back to the Home Page, click on the Gear icon.

System Summary West Rink

& % Refrigeration (5)

2 EVAPORATIVE CONDENSER @ -

e e ——
NONE™ 125.00™ Fan(s) On
A

Condensers

canT

NONE™ OF

nasr

Suction Groups
v 9 Lighting (0)
- ¥ Energy (0)
v

o QOther (14)

w [l System (6)
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A

Analog Sensor Control

Advanced

@ Logout
Collapse all | Expand all

Enh Suct 001 @
SUTONPRES.  CURP

NONE™ 22.00™ 2

Enhanced Suction

Site Supervisor Braemar CXe 2.08F01
03/12/2019 06:19:31 PM
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Figure 11-10 - Gear Icon
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12. Select My Profile on the drop-down menu.

S8 55 Unitlo Collapse all | Expandall Edit Save

e Ca Reach In Coolers @ Walk In Cooler @ Walk In Freezer @
CONTROL TEMP ACTIVE SETPT controL e 5= CONTROLTEMP ACTVE SETPT
NONE” NONE” NONE” NONE™ NONE” NONE"
File Management & Licensing A & A % @ A OB

General System Properties XR75CX 5.6 | S5 Unit XR75CX 5.6

Manage Users

Site Supervisor MikesDesk (ke 2.07F01 |
oneday @ 04/24/2019 11:56:05 AM

Figure 11-11 - My Profile

13. On my profile, click on selection beside Set Home As then chose Floorplan on the drop-down menu.

2] ® Logout

My Profile

From here you can view and edit your user profife. * Indicates required fields.

Create Keyboard Shortcuts Screen Settings
You must enter Ctr, Alr or Shift as the first part of the keyboard shortcur. Press Delete or Backspace 1o clear the shorteut
Alarms CTRL+A SELHMEAS System Summary i
-
Floorplan CTRLF Floor Plan Home Screen System Summary
4 Alarms

Select User View Level

& Basic Advanced

Select Localization Settings

Language English (United States) bl

Copyright ® 2019 Emerson Site Supervisor MikesDesk CXe 2.07F01
oneday@  04/24/2019 11:59:55 AM ¥

Figure 11-12 - Choose Floorplan
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14. Check if the Custom Screen name is automatically filled in on the Home Screen. If not, click on the selection and
chose the screen.

o
P MikesDesk 55 Unit10:2

€& IR A ot secure | profls Incognito ()

S © “ & Logout

3
EMERSON

My Profile

From here you can view and edit your user profile * Indicares required fields.

Create Keyboard Shortcuts Screen Settings

You must enter Ctrl, Alt or Shift as the first part of the keyboard shortcut. Press Delete or Backspace to clear the shorteut

Alarms ‘ Set Home As

Floorplan X

‘ Floor Plan Home Screen atket % -

‘ CTRL+A

Floorplan ‘ CTRLE

Select User View Level

® Basic Advanced

Select Localization Settings

1
Language English (United States) ¥

Site Supervisor MikesDesk CXe 2.07F01
oneday @ 04/24/2019 12:08:04 PM

Copyright ® 2019 Emerson

Figure 11-13 - Custom Screen
15. Click on the Save button to finish.

(2] & Logout

My Profile

From here you can view and edit your user profile. * indicates required fields.

Create Keyboard Shortcuts Screen Settings

You must enter Ctri, Alr or Shift as the first part of the keyboard shortcut. Press Delere or Backspace to clear the shortcut

Narms [ Crria SetHome As ‘ Floorplan v

1 Floor Plan Home Screen
Floorplan [ oo

market nd

Select User View Level

@ Basic Advanced

Select Localization Settings

Language

| English (United States) v

Copyright © 2019 Emerson Site Supervisor MikesDesk OXe 2.07F01
04/24/2019 12:08:04 PM

Figure 11-14 - Save Button
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Appendix A: Summary of Export Capability

Data to Export Connect+ Page UI Access
Advisories Advisory View Toolbar Menu and Navigation Tree
Live Advisories Live Advisory Tree Control System
Log Data Watch Points Watch Point Page

Log Graph Advisories View->Log Graph->Setting

Watch Points->Log Graph->Setting
Graphical Screens->Log Graph->Setting

Connection Verification Report

Site not Sending Alarms

Toolbar Menu

Enterprise Summary

Enterprise Summary

Toolbar Menu

Table A-1 - Summary of Export
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Appendix B: System Summary Screens

System Summary Screen UI Access Level
Refrigerant Summary Site
Building Summary Site
Other Summary Site
Summary (Controller) Unit
Summary (Application) Application Type
Defrost Summary Application Type

Graphical Status

Application Instance

Status

Application Instance

Table B-1 - System Summary Screens
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Site Level: Refrigeration Summary

Refrigeration Summary

No application instances of this type

RACK LT PSI

RACK TC 20.0 PSI

PROTOCOL A 54.0 PSI .
PROTOCOL B 63.9 PSI o QOverride

Dizplay Log Graph
Graph Cellection
Show on Real-time Graph

Baint Properti

CONDENSER A
CONDENSER B

Connection Verification Repert

Forward Advisories
View Advisories

Create Setpoint Broadoast

Configure Advisary Snooze

No application instances o

Configure C8 Maintenance
Configure Log Purge

Edit Application Instance

AK LT/TC LTBA DT MEAT
AK LT/TC LTEB DT MEAT
C LTBC DT MEAT

3 0

oK
oK
oK
oK

mom s

/GERATION -9 F .0 oF
=} EFRIGERATION -1.4 9F 0.0 °F
2] F 0.0 °F
=}
=
MT
=}

/GERATION -7.
RIGERATION 42

Site Level: Building Summary

/Damo/154 Atlanta

Building Summary

1: HVAI oF
4: E2 UnitD4 NONE ©F NONE RH NOME RH
2: oF RH NONE RH
3 oF RH NOME RH
NOMNE °F NOME °F No Ctrl
NOMNE °F NOME ©F No Ctrl
NOME °F NOME °F No Ctrl
NOME =F NONE ©F No Cirl
NOME °F NOME °F No Ctrl
NOME oF NONE ©oF No Cirl
NOME °F NOME °F No Ctrl
NOMNE °F NOME ©F No Ctrl
Ne application instances of this type OUTSIDE LIGHTS on
on
on
o

m m Refrigeration Summary | Other Summary

I Fie
NONE Fie
Ftc
Ftc

UROCC
UROCC
UROCC
uNOCC
UROCC
UNOCC
UROCC
UROCC

10101 na
MAIN OCCUPANCY o
RTU-1 OCUPANCY na
2A OCUPNCY on

B OCUPNCY on

on

on
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Site Level: Other Summary

No application instances of this type

Other Summary

NONE

°F

NONE oF

NONE

MAIN POW

MON

0 KW RESTO

COMPRESOR ROOM NONE oF orr
COMPUTER ROOM NONE °F orr
FHARMALCY NONE oF orr
AMB TMP orr
AMB TMP orr
AMB TMPCALC LT orr LT
AMB TMPCALC TC NONE oF orr ATC CONTROL TC
EMP RK LT NONE oF orr MTPREP RUM PRF
EMP RK TC NONE oF orr a
DISCH TEMP LT NONE oF on arr
m Refrigeration Summary Building Summary
.
Controller Unit Level: Controller Summar
: y
Building Controller Summary
nonEL JuonEETY JuonEETY IS Fie
1-MAIN AHU No Crl UNOCC
AHUL No Crl UNOCC
AREA No Crl UNOCC
RTU-1 No Crl UNOCC
RTU-2A PRODUCE No Crl UNOCC
RTU-2B PRODUCE No Crl UNOCC
RTU-3 KITC No Crl UNOCC
RTU-4 CONF RM No Crl UNOCC
No application instances of this o DE LIGHTS Or 10
MRKING LOT On

SALES LIGHTS

STOCK LIGHTS

o
o

CUPANCY
ATU-4 OCUPANCY
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Ref Controller Summary

Controller Summary

calion instance

Ne appl of Lhis Lype

RACK LT
RACK TC

P&l a 4
PsI 2

EEEEEEEEEE-EE

Application Type Level: Summary Screens

Circuits (Standard)
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Application Instance Level: Status Screen & Graphical Status

Status: REFRIGERATION

Contral Temp 9.3 OF
Case Temp Setpoint -12.0 9F
Term Type TIME

Refrigeration on
Defrost Off
Fanm On
LS INACTV
Clean Switch NONE
/Demo/154 Atlanta/E2/"RX-400 2: RAK LT/TC"/Circuits (Standard)/LT1 GROC
Standard Circuits Status
EMERGENCY OVR na Term Type TIME CIRCUIT STATE REFRIGERATION
CASETEMP 1 OF CASE TEMP STPT -12.0 9F REFRIG SOLENOID on
CONTROL TEMP -9.3CF CASE ALM HI SP 41.0 °F DEFROST off
CASE ALM LO SP -15.0 oF PEAK DEF TEMP 66.2 °F
COMB ALM HI 5P NONE °F FAN On
COMB ALM LO 5P NONE °F BYPASS STATE NORMAL
ACTIVE SETPT -12.0 9F ALARM OUT =

ALG STATUS OK
CASEALM OUT 1 =
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For Technical Support call 833-409-7505 or email ColdChain.TechnicalServices@Emerson.com

The contents of this publication are presented for informational purposes only and they are not to be construed as warranties or guarantees, express or implied, regarding the products or
services described herein or their use or applicability. Emerson reserves the right to modify the designs or specifications of such products at any time without notice. Responsibility for proper
selection, use and maintenance of any product remains solely with the purchaser and end-user. ©2022 Emerson is a trademark of Emerson Electric Co.
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